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• For safety and warning information, please read this 
manual before attempting to use the equipment. 

• Additional safety and warning information is provided 
within the MG3700A Vector Signal Generator 
Operation Manual (Mainframe), MG3710A Vector 
Signal Generator MG3740A Analog Signal Generator 
Operation Manual (Mainframe), 
MS2690A/MS2691A/MS2692A Signal Analyzer 
Operation Manual (Mainframe Operation), or 
MS2830A Signal Analyzer Operation Manual 
(Mainframe Operation). Please also refer to either of 
these documents before using the equipment. 

• Keep this manual with the equipment. 
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Safety Symbols 
To prevent the risk of personal injury or loss related to equipment malfunction, Anritsu Corporation uses the 
following safety symbols to indicate safety-related information. Ensure that you clearly understand the meanings of 
the symbols BEFORE using the equipment. Some or all of the following symbols may be used on all Anritsu 
equipment. In addition, there may be other labels attached to products that are not shown in the diagrams in this 
manual. 
 

Symbols used in manual 
This indicates a very dangerous procedure that could result in serious injury or 
death if not performed properly. 
 

This indicates a hazardous procedure that could result in serious injury or death if 
not performed properly. 
 
This indicates a hazardous procedure or danger that could result in light-to-severe 
injury, or loss related to equipment malfunction, if proper precautions are not taken. 

 

Safety Symbols Used on Equipment and in Manual 
The following safety symbols are used inside or on the equipment near operation locations to provide information 
about safety items and operation precautions. Ensure that you clearly understand the meanings of the symbols and 
take the necessary precautions BEFORE using the equipment. 
 
 

 
This indicates a prohibited operation. The prohibited operation is indicated 
symbolically in or near the barred circle. 

 
  This indicates an obligatory safety precaution. The obligatory operation is 

indicated symbolically in or near the circle. 
 
  This indicates a warning or caution. The contents are indicated symbolically in or 

near the triangle. 
 
  This indicates a note. The contents are described in the box. 
 
 
  These indicate that the marked part should be recycled. 

 
 
MX370111A/MX269911A WLAN IQproducer Operation Manual and 
MX283027A-001 WLAN Test Software Operation Manual (WLAN IQproducer) 
 
22 April 2011 （First Edition） 
25 November 2014 （Sixth Edition） 
 
Copyright © 2011-2014, ANRITSU CORPORATION. 
All rights reserved. No part of this manual may be reproduced without the prior written permission of the 
publisher. 
The contents of this manual may be changed without prior notice. 
Printed in Japan 

 DANGER  

 WARNING  

 CAUTION  
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Equipment Certificate 
Anritsu Corporation guarantees that this equipment was inspected at 
shipment and meets the published specifications. 
 
 

Anritsu Warranty 
• During the warranty period, Anritsu Corporation will repair or exchange this 

software free-of-charge if it proves defective when used as described in the 
operation manual. 

• The warranty period is 6 months from the purchase date. 
• The warranty period after repair or exchange will remain 6 months from 

the original purchase date, or 30 days from the date of repair or 
exchange, depending on whichever is longer. 

• This warranty does not cover damage to this software caused by Acts of 
God, natural disasters, and misuse or mishandling by the customer. 

 
In addition, this warranty is valid only for the original equipment purchaser. It 
is not transferable if the equipment is resold. 
 
Anritsu Corporation shall assume no liability for injury or financial loss of the 
customer due to the use of or a failure to be able to use this equipment. 
 
 

Anritsu Corporation Contact 
In the event that this equipment malfunctions, contact an Anritsu Service and 
Sales office. Contact information can be found on the last page of the printed 
version of this manual, and is available in a separate file on the CD version. 
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Notes On Export Management 
This product and its manuals may require an Export License/Approval by 
the Government of the product's country of origin for re-export from your 
country. 
Before re-exporting the product or manuals, please contact us to confirm 
whether they are export-controlled items or not. 
When you dispose of export-controlled items, the products/manuals need 
to be broken/shredded so as not to be unlawfully used for military purpose. 

 
 
 

 



 

v 

Software End-User License Agreement (EULA) 
Please read this Software End-User License Agreement (hereafter this EULA) carefully before using 
(includes executing, copying, registering, etc.) this software (includes programs, databases, scenarios, 
etc., used to operate, set, etc., Anritsu electronic equipment). By reading this EULA and using this 
software, you are agreeing to be bound by the terms of its contents and Anritsu Corporation (hereafter 
Anritsu) hereby grants you the right to use this Software with the Anritsu-specified equipment 
(hereafter Equipment) for the purposes set out in this EULA. 
 
1. Grant of License and Limitations 

1. Regardless of whether this Software was 
purchased from or provided free-of-charge by 
Anritsu, you agree not to rent, lease, lend, or 
otherwise distribute this Software to third 
parties and further agree not to disassemble, 
recompile, reverse engineer, modify, or create 
derivative works of this Software. 

2. You may make one copy of this Software for 
backup purposes only. 

3. You are not permitted to reverse engineer 
this software. 

4. This EULA allows you to install one copy of 
this Software on one piece of Equipment.  

2. Disclaimers 
 To the extent not prohibited by law, in no 

event shall Anritsu be liable for personal 
injury, or any incidental, special, indirect or 
consequential damages whatsoever, 
including, without limitation, damages for 
loss of profits, loss of data, business 
interruption or any other commercial 
damages or losses, arising out of or related 
to your use or inability to use this Software. 

 
 

3. Limitation of Liability 
a. If a fault (bug) is discovered in this Software, 

preventing operation as described in the 
operation manual or specifications whether 
or not the customer uses this software as 
described in the manual, Anritsu shall at its 
own discretion, fix the bug, or exchange the 
software, or suggest a workaround, 
free-of-charge. However, notwithstanding 
the above, the following items shall be 
excluded from repair and warranty.  

i) If this Software is deemed to be used for 
purposes not described in the operation 
manual or specifications. 

ii) If this Software is used in conjunction with 
other non-Anritsu-approved software. 

iii) Recovery of lost or damaged data. 
iv) If this Software or the Equipment has been 

modified, repaired, or otherwise altered 
without Anritsu's prior approval. 

v) For any other reasons out of Anritsu's direct 
control and responsibility, such as but not 
limited to, natural disasters, software virus 
infections, etc. 

b. Expenses incurred for transport, hotel, daily 
allowance, etc., for on-site repairs by Anritsu 
engineers necessitated by the above faults 
shall be borne by you. 

c. The warranty period for faults listed in 
article 3a above covered by this EULA shall 
be either 6 months from the date of purchase 
of this Software or 30 days after the date of 
repair, whichever is longer. 
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4. Export Restrictions 
 You may not use or otherwise export or 

re-export directly or indirectly this Software 
except as authorized by Japanese and 
United States law. In particular, this 
software may not be exported or re-exported 
(a) into any Japanese or US embargoed 
countries or (b) to anyone on the Japanese or 
US Treasury Department's list of Specially 
Designated Nationals or the US Department 
of Commerce Denied Persons List or Entity 
List. By using this Software, you warrant 
that you are not located in any such country 
or on any such list. You also agree that you 
will not use this Software for any purposes 
prohibited by Japanese and US law, 
including, without limitation, the 
development, design and manufacture or 
production of missiles or nuclear, chemical or 
biological weapons of mass destruction. 

5. Termination 
 Anritsu shall deem this EULA terminated if 

you violate any conditions described herein. 
This EULA shall also be terminated if the 
conditions herein cannot be continued for 
any good reason, such as violation of 
copyrights, patents, or other laws and 
ordinances. 

6. Reparations 
 If Anritsu suffers any loss, financial or 

otherwise, due to your violation of the terms 
of this EULA, Anritsu shall have the right to 
seek proportional damages from you. 

7. Responsibility after Termination 
 Upon termination of this EULA in 

accordance with item 5, you shall cease all 
use of this Software immediately and shall 
as directed by Anritsu either destroy or 
return this Software and any backup copies, 
full or partial, to Anritsu. 

8. Dispute Resolution 
 If matters of dispute or items not covered by 

this EULA arise, they shall be resolved by 
negotiations in good faith between you and 
Anritsu. 

9. Court of Jurisdiction 
 This EULA shall be interpreted in 

accordance with Japanese law and any 
disputes that cannot be resolved by 
negotiation described in Article 8 shall be 
settled by the Japanese courts. 
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Cautions against computer virus infection 
• Copying files and data 
 Only files that have been provided directly from Anritsu or generated 

using Anritsu equipment should be copied to the instrument. 
 All other required files should be transferred by means of USB or 

CompactFlash media after undergoing a thorough virus check. 
• Adding software 
 Do not download or install software that has not been specifically 

recommended or licensed by Anritsu.  
• Network connections 
 Ensure that the network has sufficient anti-virus security protection in 

place. 
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Protection Against Computer Virus Infections 

Prior to the software installation 
Before installing this software or any other software recommended or 
approved by Anritsu, run a virus scan on your computer, including 
removable media (e.g. USB memory stick and CF memory card) you 
want to connect to your computer. 
 
When using this software and connecting with the measuring instrument 
• Copying files and data 

On your computer, do not save any copies other than the following: 
 • Files and data provided by Anritsu 
 • Files created by this software 
 • Files specified in this document 

Before copying these files and/or data, run a virus scan, including 
removable media (e.g. USB memory stick and CF memory card). 

• Connecting to network 
Connect your computer to the network that provides adequate 
protection against computer viruses. 

 
 
 

Cautions on Proper Operation of Software 

This software may not operate normally if any of the following operations 
are performed on your computer: 
• Simultaneously running any software other than that recommended or 

approved by Anritsu 
• Closing the lid (Laptop computer) 
• Turning on the screen saver function 
• Turning on the battery-power saving function (Laptop computer) 
For how to turn off the functions, refer to the operation manual that came 
with your computer. 
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CE Conformity Marking 
Anritsu affixes the CE conformity marking on the following product(s) in 
accordance with the Council Directive 93/68/EEC to indicate that they 
conform to the EMC and LVD directive of the European Union (EU). 
 

CE marking 

 

1. Product Model 
Software: MX370111A/MX269911A WLAN IQproducerTM 

Software: MX283027A-001 WLAN Test Software  
 
2. Applied Directive and Standards 
 When the MX370111A/MX269911A WLAN IQproducerTM or 

MX283027A-001 WLAN Test Software is installed in the MG3710A, 
MS2690A/MS2691A/MS2692A, or MS2830A, the applied directive and 
standards of this software conform to those of the MG3710A, 
MS2690A/MS2691A/MS2692A, or MS2830A main frame. 

 
 PS: About main frame 
 Please contact Anritsu for the latest information on the main frame 

types that MX370111A/MX269911A or MX283027A-001 can be used 
with. 
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C-tick Conformity Marking 
Anritsu affixes the C-tick mark on the following product(s) in accordance with 
the regulation to indicate that they conform to the EMC framework of 
Australia/New Zealand. 
 

C-tick marking 

 

 
1. Product Model 

Software: MX370111A/MX269911A WLAN IQproducerTM 

Software: MX283027A-001 WLAN Test Software  
 

 
2. Applied Directive and Standards 
 When the MX370111A/MX269911A WLAN IQproducerTM or 

MX283027A-001 WLAN Test Software is installed in the MG3710A, 
MS2690A/MS2691A/MS2692A, or MS2830A, the applied directive and 
standards of this software conform to those of the MG3710A, 
MS2690A/MS2691A/MS2692A, or MS2830A main frame. 

 
 PS: About main frame 
 Please contact Anritsu for the latest information on the main frame 

types that MX370111A/MX269911A or MX283027A-001 can be used 
with. 
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About This Manual 

■Associated Documents 

The operation manual configuration of the MX370111A/MX269911A 
WLAN IQproducer MX283027A-001 WLAN Software (WLAN IQproduc-
er) is shown below.  

■If using MG3700A or MG3710A:  

Or 

 

MX370111A/MX269911A WLAN IQproducer™ Operation Manual and 
MX283027A-001 WLAN Software Operation Manual (WLAN IQproducer™) 
(This document) 

MG3700A /MG3710A Vector Signal Generator  
MG3740A Analog Signal Generator Operation Manual (IQproducer™) 

MG3700A  
Vector Signal Generator  
Operation Manual (Mainframe) 

MG3710A Vector Signal Generator 
MG3740A Analog Signal Generator  
Operation Manual (Mainframe) 

 
 MG3700A Vector Signal Generator Operation Manual (Mainframe) 

This describes basic operations, maintenance procedure, and remote 
functions of the MG3700A Vector Signal Generator.  

 Or 

 MG3710A Vector Signal Generator MG3740A Analog Signal Generator 

Operation Manual (Mainframe) 

This describes basic operations, maintenance procedure, and remote 
functions of the MG3710A Vector Signal Generator and the MG3740A 
Analog Signal Generator.  

 

 MG3700A/MG3710A Vector Signal Generator MG3740A Analog Signal 

Generator Operation Manual (IQproducer™) 

This describes the functions and how to use the IQproducer, which is 
Windows software for the Vector Signal Generator and the Analog Signal 
Generator. 
 

 MX370111A/MX269911A WLAN IQproducerTM Operation Manual and 

MX283027A-001 WLAN Software Operation Manual (WLAN IQproduc-

erTM) (This document) 

This describes basic operations and functions of the WLAN IQproducer™ 
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■If using MS2690A/MS2691A/MS2692A or MS2830A without 
MX283027A-001:  

MX370111A/MX269911A WLAN IQproducer™ Operation Manual and 
MX283027A-001 WLAN Software Operation Manual (WLAN IQproducer™)  
 

 

MS2690A/MS2691A/MS2692A 
Signal Analyzer Operation Manual 
(Main Frame Operation) 

MS2690A/MS2691A/MS2692A and MS2830A  
Signal Analyzer Operation Manual (Main Frame Remote Control) 

MS2830A Signal Analyzer 
Operation Manual  
(Main Frame Operation) Or 

MS2690A/MS2691A/MS2692A 
Signal Analyzer Option 020:  
Vector Signal Generator  
Operation Manual  
(Operation) 

MS2830A 
Signal Analyzer 
Vector Signal Generator 
Operation Manual  
(Operation) 

Or 

MS2690A/MS2691A/MS2692A 
Signal Analyzer Option 020: 
Vector Signal Generator 
Operation Manual 
(Remote Control) 

MS2830A Signal Analyzer  
Vector Signal Generator 
Operation Manual  
(Remote Control) Or 

MS2690A/MS2691A/MS2692A and MS2830A 
Vector Signal Generator Operation Manual (IQproducer™)
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 MS2690A/MS2691A/MS2692A Signal Analyzer Operation Manual (Main-

frame, Operation) 

This describes basic operations, maintenance procedure, common func-
tions and common remote functions of the MS2690A/MS2691A/MS2692A.  

Or 

 MS2830A Signal Analyzer Operation Manual (Mainframe, Operation) 

This describes basic operations, maintenance procedure, common func-
tions and common remote functions of the MS2830A.  
---------------------------------------------------------------------------------------------- 

 MS2690A/MS2691A/MS2692A and MS2830A Signal Analyzer Operation 

Manual (Mainframe, Remote Control) 

These describe basic operations, maintenance procedure, common func-
tions and common remote functions of the MS2690A/MS2691A/MS2692A 
or MS2830A.  
---------------------------------------------------------------------------------------------- 

 MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector Signal 

Generator Operation Manual, Operation 

This describes the functions and how to use the Vector Signal Generator 
option. 

Or 

 MS2830A Vector Signal Generator Operation Manual, Operation 

This describes the functions and how to use the Vector Signal Generator 
option. 
---------------------------------------------------------------------------------------------- 

 MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector Signal 

Generator Operation Manual, Remote Control 

This describes how to remotely control the Vector Signal Generator op-
tion.  

Or 

 MS2830A Vector Signal Generator Operation Manual, Remote Control 

This describes how to remotely control the Vector Signal Generator op-
tion. 
---------------------------------------------------------------------------------------------- 

 MS2690A/MS2691A/MS2692A and MS2830A Vector Signal Generator 

Operation Manual (IQproducer™) 

This describes the functions and how to use the IQproducer, which is 
Windows software for the Vector Signal Generator option. 
---------------------------------------------------------------------------------------------- 

 MX370111A/MX269911A WLAN IQproducerTM Operation Manual and 

MX283027A-001 WLAN Software Operation Manual (WLAN IQproduc-

erTM) (This document) 

This describes basic operations and functions of the WLAN IQproducer™. 



IV 

■If using MS2830A or MX283027A-001: 

 

MS2690A/MS2691A/MS2692A and MS2830A  
Vector Signal Generator Operation Manual (IQproducer™) 

MX370111A/MX269911A/WLAN IQproducer™ Operation Manual  
and  
MX283027A-001 WLAN Test Software Operation Manual (WLAN IQproducer™) 

MS2690A/MS2691A/MS2692A and MS2830A  
Signal Analyzer Operation Manual (Mainframe, Remote Control) 

MS2830A  
Signal Analyzer Operation Manual (Mainframe Operation) 

MS2830A Vector Signal Generator  
Operation Manual (Operation) 

MS2830A Vector Signal Generator  
Operation Manual (Remote Control) 

MX283027A Wireless Network Device Test Software  
Operation Manual (Operation) 

MX283027A-001 WLAN Test Software  
Operation Manual (Operation) 

MX283027A-001 WLAN Test Software  
Operation Manual (Remote Control) 

 
 

 MS2830A Signal Analyzer Operation Manual (Mainframe Operation) 

This describes basic operations, maintenance procedure, common func-
tions and common remote functions of the MS2830A. 

---------------------------------------------------------------------------------------------- 

 MS2690A/MS2691A/MS2692A and MS2830A Signal Analyzer Operation 

Manual (Mainframe, Remote Control) 

These describe basic operations, maintenance procedure, common func-
tions and common remote functions of the MS2690A/MS2691A/MS2692A 
or MS2830A. 
---------------------------------------------------------------------------------------------- 
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 MS2830A Vector Signal Generator Operation Manual (Operation) 

This describes the functions and how to use the Vector Signal Generator 
option. 
---------------------------------------------------------------------------------------------- 

 MS2830A Vector Signal Generator Operation Manual (Remote Control) 

This describes how to remotely control the Vector Signal Generator op-
tion. 
---------------------------------------------------------------------------------------------- 

 MS2690A/MS2691A/MS2692A and MS2830A Vector Signal Generator 

Operation Manual (IQproducer™) 

This describes the functions and how to use the IQproducer, which is 
Windows software for the Vector Signal Generator option. 
---------------------------------------------------------------------------------------------- 

 MX283027A Wireless Network Device Test Software Operation Manual 

(Operation) 

This describes basic operations and functions of the MX283027A Wireless 
Network Device Test Software. 
---------------------------------------------------------------------------------------------- 

 MX283027A-001 WLAN Test Software Operation Manual (Operation) 

This describes the functions and how to use the MX283027A-001 WLAN 
Test Software.  

---------------------------------------------------------------------------------------------- 

 MX283027A-001 WLAN Test Software Operation Manual (Remote Control) 

This describes the remote operation of MX283027A-001 WLAN Test 
Software.  
---------------------------------------------------------------------------------------------- 

 

 MX370111A/MX269911A/WLAN IQproducer™ Operation Manual  

and  

MX283027A-001 WLAN Test Software Operation Manual (WLAN IQpro-

ducer™) <This document> 

This describes basic operations and functions of the WLAN IQproducer. 
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This chapter provides an overview of the WLAN IQproducer. 
 

1.1 Product overview ....................................................... 1-2 
1.2 Product Composition ................................................. 1-3 
1.3 Options ....................................................................... 1-4 
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1.1 Product overview 
WLAN IQproducer (hereinafter referred to as (hereinafter referred to 
as “this software”) is software used to generate waveform patterns 
conforming to the IEEE Std 802.11-2007 and IEEE Std 802.11n-2009 
specifications. Also, adding an option enables the software to generate 
waveform patterns conforming to the IEEE P802.11ac/D2.0, January 
2012. 

This software requires either of the following environment: 

• MG3710A Vector Signal Generator 
• MS2690A/MS2691A/MS2692A or MS2830A Signal Analyzer with 

Vector Signal Generator option mounted 
• Personal computer (hereinafter, “PC”) 
 
This software generates waveform patterns that support the 
specifications of IEEE 802.11a/b/g/j/n/p with various characteristics. This 
is made possible by the editing/customizing of parameters according to 
its use.  Also, adding the MX370111A-001/-002/MX269911A-001 to 
generate waveform patterns conforming to the IEEE P802.11ac.  

A waveform pattern created by this software can be output using an RF 
signal after being downloaded into the MG3700A Vector Signal Generator, 
MG3710A Vector Signal Generator , or an MS2690A/MS2691A/MS2692A 
Signal Analyzer with Vector Signal Generator option installed 
(collectively referred to as “mainframe”, or “this equipment”). 

Note: 
To use waveform patterns generated by IQproducer Version 14.01 
or later on the MG3710A Vector Signal Generator, use the 
MG3710A Package V2.01.00 or later. 
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1.2 Product Composition 
The following table lists the model name and specifications of this 
software according to the equipment. 

Table 1.2-1  Restrictions 

Mainframe 

 

Restrictions 

MG3700A MG3710A 
MS2690A 
MS2691A 
MS2692A 

MS2830A 

Software name MX370111A MX269911A MX269911A/ 
MX283027A-001 

Maximum Size 
of Waveform 
Patterns 

256 M sample 
512 M sample*1 

64 M sample 
128 M sample*5 
256 M sample*6 
512 M sample*7 

256 M sample 64 M sample 
256 M sample*4 

Transmission 
method of 
Waveform 
Patterns 

LAN, 
CompactFlash 
Card 

External device 
such as LAN, 
USB memory*2 

USB Memory 
and other 
external device *2 

USB Memory 
and other 
external device *2 

Installation of 
this software 
to this 
equipment 

N/A Possible  Possible *3 Possible *3 

 
*1: The ARB memory expansion 512M sample (optional) must be 

installed into the MG3700A to use waveform patterns that exceed 
256 M samples. 

*2: Transferring waveform patterns is not required if the waveform 
patterns are created on the equipment using this software. 

*3: Although this software can be installed and run in the 
MS2690A/MS2691A/MS2692A or MS2830A, the measurement 
functions of the MS2690A/MS2691A/MS2692A or MS2830A are not 
guaranteed while this software runs. 

*4: The ARB memory expansion 256M sample (optional) must be 
installed into the Vector Signal Generator option to use waveform 
patterns of 64 M samples or more.  

*5: The Combination of Baseband Signal (optional) must be installed 
into the MG3710A to use waveform patterns of maximum 128 M 
samples. 

*6: The ARB memory expansion 256M sample (optional) must be 
installed into the MG3710A to use waveform patterns of maximum 
256 M samples.  
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*7: To use waveform patterns of maximum 512 M samples, either of the 
following must be installed into MG3710A: 

• ARB memory expansion 1024 M sample (optional) 

• ARB memory expansion 256 M (optional) and Combination of 
Baseband Signal (optional) 

 
■Notes on waveform pattern conversion 

The waveform patterns generated with this software varies according to 
the main unit type. If using the waveform pattern to the different main 
unit, you need to convert the waveform pattern.  

For details about how to convert a waveform pattern, refer to each one of 
the following manuals.  

• MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™) 
4.5 “File Conversion on Convert Screen” 

• MS2690A/MS2691A/MS2692A and MS2830A Vector Signal Generator 
Operation Manual (IQproducer™) 
4.5 “File Conversion on Convert Screen”  

 

1.3 Options 
Table 1.3-1 shows the options for this application. 

Table 1.3-1  Options 

Model/Symbol Product name Remarks 

MX370111A-001 802.11ac(80MHZ) Option 
For MG3700A, 
Generates waveform patterns 
for IEEE802.11ac. 

MX269911A-001 802.11ac(80MHZ) Option 
For MS269xA/MS2830A 
Generates waveform patterns 
for IEEE802.11ac. 

MX370111A-002 802.11ac(160MHZ) Option 
For MG3710A 
Generates waveform patterns 
for IEEE802.11ac. 
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This chapter describes the operating environment for the 
MX370111A/MX269911A. 
 

2.1 Operating Environment .............................................. 2-2 
2.2 Installation/Uninstallation ........................................... 2-3 
2.3 Starting up and exiting the software .......................... 2-4 

2.3.1 Starting Software: When installed  

on other than MG3710A ................................ 2-4 
2.3.3 Starting Software: When installed  

on MG3710A ................................................. 2-6 
2.3.4 Exiting Software ............................................. 2-7 

 

 



 

Chapter 2  Preparation 

2-2 

2.1 Operating Environment 
The following environment is required for operating the 
MX370111A/MX269911A. 

(1) PC that meets the following conditions 

OS Windows XP/Windows Vista/Windows 7 
CPU Pentium III 1 GHz equivalent or faster 
Memory 512 MB or more 

Hard disk space 

5 GB or more free space in the drive where 
this software is to be installed.  
The free hard disk space necessary to create 
waveform pattern varies depending on the 
waveform pattern size. The free disk space of 
27 GB or greater is required to create four 
maximum (512 M sample) waveform patterns.

 
(2) If viewing on PC, displays with a resolution of 1024 × 768 pixels are 

best viewed using a small font setting. 
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2.2 Installation/Uninstallation 
This software is included in the IQproducer™ installer. It is 
automatically installed by installing the IQproducer™ that is supplied 
with this equipment or this software. When using a waveform pattern 
created using this software in the equipment, the license file must be 
installed in advance. 

■Installing/Uninstalling IQproducer™ 

For how to install IQproducer™, refer to each of the following manuals:  

 MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™) 
Chapter 2 “Installation” 

 MS2690A/MS2691A/MS2692A and MS2830A Vector Signal Generator 
Operation Manual (IQproducer™) 
Chapter 2 “Installation” 

 

■Installing/Uninstalling IQproducer™ license file 

For how to install license file to MG3700A/MG3710A, refer to the 
following manual:  

 MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™) 
5.1 “Installing License File” 
 

For how to uninstall license file from MG3700A/MG3710A, refer to each 
one of the following manuals:  

 MG3700A Vector Signal Generator Operation Manual (Mainframe) 
3.10.10 “Install” 

 MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (Mainframe) 
9.4.4 “Install” 

 
Refer to the following manual for details of how to install/uninstall 
license file to MS2690A/MS2691A/MS2692A or MS2830A with Vector 
Signal Generator option.  

 MS2690A/MS2691A/MS2692A and MS2830A Vector Signal Generator 
Operation Manual (IQproducer™) 
2.2 “Installation/Uninstallation” 
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2.3 Starting up and exiting the software 
This section explains how to start and stop this software. 

Note: 

The following explanation assumes the use of Windows XP. The 
screen image may differ slightly if not using Windows XP.  

 

2.3.1 Starting Software: When installed on other than MG3710A 
Start this software using the following procedure.  
The example assumes that it is a PC operation.  
 

<Procedure> 

1. Click Start on the task bar, and point to All Programs. Next, point to 
Anritsu Corporation, point to IQproducer, and then click 
IQproducer. 

 

2. When IQproducer™ starts, the Select instrument screen is 
displayed. 

On the Select instrument screen, select the model of the main unit 
that uses the waveform patterns created by IQproducer™.  

Notes: 

 This software does not support MG3740A. 

 To hide this screen and to start with the selected mainframe's 
screen from the next time, select the Don't show this window 
next time check box. 
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3. The common platform screen is displayed when OK is clicked in the 
Select instrument screen.  

The common platform screen is a screen used to select each function 
of the IQproducer™.  

 

 

Figure 2.3.1-1  Common Platform Screen 

 

4. Click the System (Non-Cellular) tab on the common platform screen, 
to show the System (Non-Cellular) selection screen that supports 
each telecommunication system.  

 

 

Figure 2.3.1-2  System (Non-Cellular) Selection Screen 

 

5. Click WLAN to display the main screen. For details of the main 
screen, refer to Chapter 3 “Normal Setup Screen”.  

Note: 

If Change Instrument is clicked, the Select instrument screen will 
appear each time the software is loaded.  
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2.3.2 Starting Software: When installed on MG3710A 
Start this software using the following procedure.  

<Procedure> 

1. Press  on the MG3710A front panel to display the common 
platform screen.  

The common platform screen is a screen used to select each function 
of the IQproducer™.  

 

Figure 2.3.2-1  Common Platform Screen 

 

2. Click the System (Non-Cellular) tab on the common platform screen, 
to show the System (Non-Cellular) selection screen that supports 
each telecommunication system.  

 

Figure 2.3.2-2  System (Non-Cellular) Selection Screen 
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3. Click WLAN to display the main screen. For details of the main 
screen, refer to Chapter 3 “Normal Setup Screen”.  

Note: 

When this software is installed on MG3710A, Change Instrument 
displays instead of Interface Settings. Clicking Interface Settings 
displays the Interface Setting dialog box.  

 

Figure 2.3.2-3  Interface Settings Dialog Box 

 

Here, you can configure interface-related settings of IQproducer 
and MG3710A. To return to factory defaults, click Default. 

 Row Socket Port Number 

Sets Row Socket port number. Set the same value as that for 
MG3710A.  

 Wait Time 

Sets the wait time between commands.  

2.3.3 Exiting Software 
Stop this software using the following procedure. 
■When exiting only this software 
To exit only this software without closing the Common Platform screen, 
or other IQproducer™ tools, do one of these below: 

 Click the Exit button ( ) on the tool bar. 

 Select Exit from the File menu. 

 Click the  button on the upper right screen. 

 

Figure 2.3.3-1  Exiting Software 
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The operation of the three screen buttons is explained below.  

 

 

Figure 2.3.3-2  Exit Confirmation Window 

 

 Yes Saves current parameters to file and stops this 
software. 

 No Stops this software without saving current 
parameters to file. 

 Cancel or  Cancels the process and returns to the main screen. 
 
When stopping this software using the Yes button, the saved parameters 
are read at the next start and reset for each parameter.  

■When exiting entire IQproducer™ application 

To exit all tools of IQproducer™ that are running, select Exit on the 
Common Platform Screen. In this case, a dialog is displayed to confirm 
stopping of each running tool.  

 

Figure 2.3.3-3  Exiting IQproducer™ 

 

 



 
Chapter 3  Normal Setup Screen 

3-1 

3 

N
orm

al S
etu

p S
creen

This chapter describes the detailed functions when this software is used 
on Normal Setup screen. 

Notes: 

 The examples and screens used throughout this chapter are 
based on the assumption that the IQproducer™ is activated 
with the MG3700A.  

 The MG3710A, MS2690A/MS2691A/MS2692A, and MS2830A 
functions are described as notes in each item. 

 

3.1 Screen Details ............................................................... 3-2 
3.1.1 Menu and tool button ........................................ 3-2 

3.1.2 Tree view ........................................................ 3-10 
3.1.3 List of Common Parameter ............................ 3-12 
3.1.4 PHY/MAC parameters .................................... 3-32 
3.1.5 Export File screen ........................................... 3-55 
3.1.6 Calculation screen .......................................... 3-61 
3.1.7 Calculation & Load ......................................... 3-63 
3.1.8 Calculation & Play .......................................... 3-64 

3.2 Waveform Pattern Generation Procedure .................. 3-66 

3.2.1 IEEE 802.11n waveform ................................. 3-66 
3.2.2 IEEE 802.11ac waveform ............................... 3-69 

3.3 Saving/Reading Parameters ....................................... 3-72 
3.3.1 Saving a parameter file .................................. 3-72 
3.3.2 Reading a parameter file ................................ 3-73 

3.4 User File Reading Screen ........................................... 3-75 
3.5 Graph Display ............................................................. 3-77 
3.6 Auxiliary Signal Output ............................................... 3-83 
 

 



 

Chapter 3  Normal Setup Screen 

3-2 

3.1 Screen Details 
3.1.1 Menu and tool button 

On common platform screen, click the System (Non-Cellular) tab, and 
then click WLAN to display the main screen. 

“System=Other than 11ac” and “System=11ac” can be switched by 
System in the common parameter list.  
For details, see 3.1.3 “List of Common Parameter”. 

 

 

 

Tool bar 

Tree view 

Common 
parameter list 

PHY/MAC 
parameter list 

Easy Setup button Menu bar 

   

 

Figure 3.1.1-1  Main screen (except 11ac) 

 



 

3.1 Screen Details 

3-3 

3 

N
orm

al S
etu

p S
creen

 

 

 

Tool bar

Tree view 

Common 
parameter list

PHY/MAC 
parameter list

Easy Setup button Menu bar 

   

 

Figure 3.1.1-2  Main screen (11ac) 

 

■ Basic operations of the main screen 

 The window can be maximized, minimized, expanded, and reduced.  

 For the fields of the tree view, common parameter list, PHY/MAC 
parameter list, splitting position can be changed by dragging their 
boundaries. 

 The leftmost symbol of each item in the tree view is - when the 
integrated items are open, or + when they are closed. Clicking the 
mark changes the status.  

 The items in italic cannot be changed. These items are 
automatically set. The state of each item may change depending on 
the setting for other items.  

 The grayed out items indicate the parameters not related to the 
generated waveforms in the current setting and cannot be changed. 
The state of each item may change depending on the setting for 
other items.  
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■ Screen transition 

Figure 3.1.1-3 shows transition from the main screen that is displayed 
when the WLAN IQproducer™ is started up to other screens (Export File 
and Calculation screens). For details on each of the screens, refer to the 
sections shown below the corresponding screen. 

 

OK 

Main screen 

Cancel

Calculation 

Calculation 
completed: 
OK button 

During calculation: 
Cancel button 

Export File screen 
(Refer to 3.1.5 “Export File screen.”)

Calculation screen for waveform generation
(Refer to 3.1.7 “Calculation & Load”.) 

 

Figure 3.1.1-3  Screen transition 
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■ File menu  

 

Figure 3.1.1-4  File menu 

 

 Select Option 

Notes: 

 This function is available only when MG3700, MG3710 or 
MS2830 is selected in the Select instrument screen. 

 ARB Memory Expansion (option) is not available for 
MS269xA. Only Memory 256M samples, 1 GB is available.  

■ When using MG3700A or MS2830A 

 Select whether the ARB memory expansion option 256Msamples is 
installed. Selecting With Option21 (Memory 512M samples)/With 
Option27 (Memory 256M samples) supports creation of larger 
waveform patterns. If the ARB memory expansion option is not 
installed, the generated waveform pattern may not be able to be 
used. Waveform patterns cannot be created with a size greater than 
256Msamples or 64M samples when Without Option21 (Memory 
512M samples)/Without Option27 (Memory 256M samples) is 
selected. Select either according to the presence of ARB memory 
expansion option. 

Table 3.1.1-1  Available Options for MG3700A or MS2830A 

Model Items 
ARB Memory 

Expansion 

MG3700A 

With Option21 (Memory 512M 
samples) 

1 GB × 2 
memory 

Without Option21 (Memory 
512M samples): 

512 MB × 2 
Memories 

MS2830A 

With Option27 (Memory 256M 
samples) 1 GB 

Without Option27 (Memory 
256M samples) 256 MB 
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■ When using MG3710A 

 The presence/absence of the ARB Memory Expansion (option) and 
Baseband Signal Combination Function (option) is selected. 
Selecting the ARB Memory Expansion (option) and the Baseband 
Signal Combination Function (option) generates a bigger waveform 
pattern, while selecting the Baseband Signal Combination Function 
(option) generates a waveform pattern. If an uninstalled option is 
selected, sometimes the created waveform pattern may not be 
usable.  

 Set the combination of installed options based on the following 
setting items.  

Table 3.1.1-2  Available Options for MG3710A 

Items Combinations of Options 

Memory 64M samples None 

Memory 64M samples × 2 
Option48 
and 
Option 78 

Memory 256M samples 
Option45 
or 
Option 75 

Memory 256M samples × 2 
Option 45 and Option 48 
or 
Option 75 and Option 78 

Memory 1024M samples 
Option46 
or 
Option 76 

Memory 1024M samples × 2 
Option 46 and Option 48 
or 
Option 76 and Option 78 

 

The maximum size of the generated waveform pattern for each of 
the setting items is shown below.  

Table 3.1.1-3  Waveform Pattern Maximum Size 

Items Maximum Size 

Memory 64M samples 64M samples 
Memory 64M samples × 2 (With 
Option48, 78) 128M samples 

Memory 256M samples 256M samples 
Memory 256M samples × 2 (With 
Option48, 78) 512M samples 

Memory 1024M samples 512M samples 
Memory 1024M samples × 2 (With 
Option48, 78) 512M samples 
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 Recall Parameter File 

Loads the parameter files saved by the Save Parameter File menu. 
When the parameter file is loaded, the settings when it was loaded 
are recovered.  

 Save Parameter File 

Saves the current setting parameters to a file. 

 Exit 

Exits from this application. 

 

■ Edit Menu 

 

Figure 3.1.1-5  Edit menu 

 

 Calculation 

Generates waveform patterns. 

 Calculation & Load  

Note: 

This function is available only when this software is used on 
MG3710A. 

After waveform generation is finished, the created waveform 
pattern is loaded into the MG3710A waveform memory.  

 Calculation & Play  

Note: 

This function is available only when this software is used on 
MG3710A. 

After waveform generation is finished, the created waveform 
pattern is loaded and selected at the MG3710A waveform memory.  

 Clipping 

Displays the Clipping setting screen. In this screen, clipping and 
filtering processing can be performed for a generated waveform 
pattern.  
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■ Transfer Setting Menu 

 

Figure 3.1.1-6  Transfer Setting menu 

 

 Transfer Setting Wizard 

Note: 

This function is available only when MG3700 or MG3710 is 
selected in the Select instrument screen.  

Displays the Transfer Setting Wizard screen. Every operation 
ranging from connecting the PC and MG3700A/MG3710A and 
transferring the waveform pattern to the MG3700A/MG3710A, to 
loading the waveform pattern into the MG3700A/MG3710A ARB 
memory is performed at this screen.  

 

■ Simulation menu 

 

Figure 3.1.1-7  Simulation menu 

 

 CCDF 

Displays the CCDF Graph Monitor screen.  
In this screen, the CCDF of the generated waveform pattern is 
displayed in a graph.  

 FFT 

Displays the FFT Graph Monitor screen. In this screen, the 
FFT-processed spectrum of the generated waveform pattern is 
displayed in a graph.  

 Time Domain 

Displays the Time Domain screen. In this screen, the time domain 
waveform of a generated waveform pattern is displayed in a graph.  
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■ Tool buttons 

Notes: 

 Transfer&Setting Wizard is available only when MG3700 or 
MG3710 is selected in the Select instrument screen.  

 Calculation & Load and Calculation & Play are available 
only when this software is used on MG3710A. 

 

  Recall Parameter File 

  Save Parameter File 

  Calculation 

  Calculation & Load 

  Calculation & Play 

 Transfer & Setting Wizard 

 CCDF 

 FFT 

 Time Domain 

 Clipping 

  Exit 

Easy Setup 

 

Clicking a tool button operates the same as the corresponding 
commands in the menu.  
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3.1.2 Tree view 
The tree view displays the parameter that belongs to the waveform 
pattern to be created in the hierarchy structure.  

■ System = other than 11ac 

 

 

Figure 3.1.2-1  Tree view 

 

 Right-clicking MPDU or A-MPDU opens a pop-up menu that contains 
the following items: 

Add MPDU: Adds A-MPDU.  

Delete MPDU: Deletes A-MPDU.  

 The PHY/MAC parameter list shows the A-MPDU parameter list for 
the items selected in the tree view.  

 Adding and deleting A-MPDU is effective only when A-MPDU is On. 
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■ System=11ac 

 

Figure 3.1.2-2  Tree view 

 

User# 

Up to four users from USER#0 to #3 can be set. However, a new User# 
cannot be added when the Total Number of Space Time Streams and the 
Number of Transmit Chains match. MPDU/A-MPDU# are displayed 
under each User#. Right-click to display menu to add and delete user#. 
 

 Adding and deleting user# is effective only when the user mode is 
Multi User. 

 
MPDU/A-MPDU# 

Up to sixteen A-MPDUs from A-MPDU#1 to #16 can be set.  
The main screen is updated each time MPDU/A-MPDU# is selected.  
Right-click to display menu to add and delete MPDU/A-MPDU#. 
 

 The PHY/MAC parameter list shows the parameter list of 
MPDU/A-MPDU# that belong to the user# selected in the tree view. 

 The setting items for Common and IEEE802.11ac are always 
displayed on the left of the main screen. 

 Adding and deleting A-MPDU is effective only when A-MPDU is On. 
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3.1.3 List of Common Parameter 
The items displayed in the common parameter list are described below.  
Parameters that require setting are listed in the common parameter list.  
The common parameters are displayed under Common.  

System 

[Function] Sets System standard.  
[Default] 11g 
[Setting range] 11a, 11ac, 11b, 11g, 11j, 11n, 11p 
[Remarks] Switching the system standard changes the common 

parameter list and the PHY/MAC parameter list on 
display. 

 

3.1.3.1 Common parameter list (System = other than 11ac) 

 
Number of Packets 

[Function] Sets the number of packets to be generated. 
[Default] 1 
[Setting range] 1 to the maximum capacity of waveform memory 
 
Number of Antennas 

[Function] Displays the number of antennas.  
[Default] 1 
[Display range] 1 to 4 
[Remarks] Displays the same value of Number of Transmit Chains 

in the following conditions:  
 When System=11n, and PPDU Format=HT Mixed/HT 

Greenfield 
 The setting is fixed to 1 when the System is other than 

11n.  
 
Convolutional Encode 

[Function] Enables/disables convolutional encoding.  
[Default] On 
[Setting range] On, Off 
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Interleave 

[Function] Enables/disables interleave processing.  
[Default] On 
[Setting range] On, Off 
[Remarks] This is available in the following conditions:  
 System=11a, 11j, 11n, 11p, 
 When System=11n, and Frame 

Format=DSSS-OFDM/ERP-OFDM  
 

Scramble 

[Function] Enables/disables scramble processing.  
[Default] On 
[Setting range] On, Off 
 
Scramble Initial Value 

[Function] Sets the initial value of scramble processing.  
[Default] 0x5D 
[Setting range] 0x00 to 0x7F 
[Remarks] Available only for 11a, 11n, and 11ac. 
 

PBCC Encode 

[Function] Enables/disables PBCC encoding.  
[Default] On 
[Setting range] On, Off 
[Remarks] This is available in the following conditions:  

System=11b and High Rate Modulation=PBCC 
System=11g and Frame Format=ERP-PBCC 

 
Oversampling Ratio 

[Function] Sets oversampling ratio. 
[Default] 2 
[Setting range] 2, 4, 8 
[Remarks] The setting range for each system is as follows: 

System=11b: 4, 8 
  System=11a, 11g, 11j, 11n, 11p : 2,4,8 

Note, however, that the setting range is 4 and 8 if System 
= 11g and Data Rate = 1, 2, 5.5, 11, 22, 33 Mbps 

Note, however, that the setting range is 2 and 4 if System 
= 11n and Bandwidth = 40 MHz.  
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Sampling Rate 

[Function] Displays the sampling rate. 
[Remarks] The following table shows the corresponding sampling 

rate for each system: 

 

System Sampling rate 

System=11a 20 MHz×Oversampling Ratio 
System=11b 11 MHz×Oversampling Ratio 
System=11g  
(Data Rate=1,2,5.5,11 Mbps) 

11 MHz×Oversampling Ratio 

System=11g  
(Data Rate=other than 1,2,5.5,11 
Mbps) 

20 MHz×Oversampling Ratio 

System=11j 20 MHz×Oversampling Ratio 
System=11n  
(BW=20 MHz) 

20 MHz×Oversampling Ratio 

System=11n  
(BW=40 MHz) 

40 MHz×Oversampling Ratio 

System=11p 10 MHz×Oversampling Ratio 

 

Bandwidth 

[Function] Set bandwidth. 
[Default] The default value for each System is as follows:  
 

System Default 

System=11a 20 MHz 
System=11j 20 MHz 
System=11n 20 MHz 
System=11p 10 MHz 

 
[Setting range] The setting range for each system is as follows: 
 

System Setting Range 

System=11a 20 MHz 
System=11j 20 MHz 
System=11n 20 MHz or 40 MHz 
System=11p 10 MHz 

 
[Remarks] Not available when System=11b, 11g.  

 



 

3.1 Screen Details 

3-15 

3 

N
orm

al S
etu

p S
creen

 

Duty Cycle 

[Function] Sets the On/Off ratio of the burst signal.  
[Default] 50.0000 [%] 
[Setting range] 0.1000 to 99.0000 [%] 
[Resolution] 0.0001 
[Remarks] When Duty Cycle is set, Burst Off Length and Burst 

Period is automatically calculated. When Burst On length 
and Burst Off Length is changed, Duty Cycle is 
automatically calculated.  

 The setting range is automatically calculated according to 
the Common, PHY, MAC parameter settings, so it is not 
always from 0.1000 to 99.0000 [%]. 

 

Burst On Length 

[Function] Displays Burst On Length [s].  
[Display range] Displays the calculated value.  
[Resolution] 0.001 
[Remarks] The calculated result is rounded to a multiple of 

1/Sampling Rate [s].  

  Automatically calculated by PHY/MAC parameter 
setting. 

 

Burst Off Length 

[Function] Displays Burst Off Length [s].  
[Setting range] The setting range is decided by the maximum and 

minimum values of Duty Cycle and the calculated value 
of Burst On Length. 

[Resolution] 0.001 
[Remarks] When setting Burst Off Length, Duty Cycle and Burst 

Period are automatically calculated.  
 Also, Burst Off Length is calculated from the values of 
Duty Cycle and Burst On Length as below. 
Burst Off Length=  

Burst On Length × (100.0 – Duty Cycle) / Duty Cycle 
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Burst Period 

[Function] Displays Burst Period [s].  
[Display range] Displays the calculated value.  
[Remarks] The following figure shows the relationships among Duty 

Cycle, Burst On Length, Burst On Length, and Burst 
Period: 

 

 
T1 : Burst On Length 
T2 : Burst Off Length 
T3 : Burst Period 
T1/T3 : Duty Cycle 

 
Repeat Count  

[Function] Sets the repeat count of packet to be transmitted.  
[Default] 1000 
[Setting range] 1 to 32767 

[Remarks] This setting is void if MS269x or MS2830A is selected in 
the Select instrument dialog box.  

 

A-MPDU 

[Function] Enables/disables A-MPDU.  
[Default] Off 
[Setting range] On, Off 
[Remarks] Available in the following conditions:  
  System=11n and PPDU Format=HT Mixed, or HT 

Greenfield 
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Filter 

Filter Type 

[Function] Sets the filter type. 
[Default] The default value for each System is as follows:  
 System=11b or,  

 System=11g, and when Frame Format is NOT 
ERP-OFDM/DSSS-OFDM: Gaussian 
Other than above: None 

[Setting range] None, Gaussian, Root Nyquist, Nyquist, Ideal 
 

Roll Off/BT 

[Function] Sets the roll-off factor or BT product.  
[Default] 0.50 
[Setting range] 0.01 to 1.00 
[Resolution] 0.01 
[Remarks] The setting is not available when Filter Type is set to 

Ideal or None.  
 

Spectrum shaping 

Windowing Length 

[Function] Sets the windowing length.  
[Default] 8 Sample 
[Setting range] 0 to 32×Oversampling Rate 
[Remarks] This setting is not available in the following conditions: 

System=11b 
System=11g, and when Frame Format is NOT 
ERP-OFDM/DSSS-OFDM 

 

Ramp Length 

[Function] Sets the ramp length.  
[Default] 8 Sample 
[Setting range] 0 to 16×Oversampling Rate 
[Remarks] Available in the following conditions:  
  System=11b 

 System=11g, and when Frame Format is NOT 
ERP-OFDM/DSSS-OFDM 
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3.1.3.2 Common parameter list (System = 11ac) 

 
Number of Packets 

[Function] Sets the number of packets to be generated. 
[Default] 1 
[Setting range] 1 to the maximum number of packets for the waveform 

memory.  
 
Number of Antennas 

[Function] Displays the number of antennas.  
[Default] 1 
[Setting range] 1 to 8 
[Remarks] Displays the same value of Number of Transmit Chains.  
 
Total Output Packets  

[Function] Displays the total number of packets  
(Number of Packets × Repeat Count). 

[Default] 1000 
[Remarks] The setting is void if MS269x or MS2830 is selected in the 

Select instrument dialog box. 
 
Oversampling Ratio 

[Function] Sets the oversampling ratio.  
[Default] 2 
[Setting range] 2, 4, 8 
[Remarks] Bandwidth=40 MHz: 2,4, 

Bandwidth=80 MHz / 80+80 MHz: 2 only.  
Bandwidth = 160 MHz: invalid.  

 
Sampling Rate 

[Function] Displays sampling rate.  
[Remarks] Bandwidth MHz × Oversampling Ratio 

When the bandwidth is 160 MHz, the sampling rate is 
fixed to 200 MHz. 

 
Bandwidth 

[Function] Sets the bandwidth. 
[Default] 20 MHz 
[Setting range] 20 MHz, 40 MHz, 80 MHz, 160 MHz, 80+80 MHz  
[Remarks] 160 MHz is not settable if MG3700A, MS269x, or MS2830 

is selected in the Select instrument dialog box. 
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Duty Cycle 

[Function] Sets the On/Off ratio of the burst signal.  
[Default] 50.0000 [%] 
[Setting range] 0.1000 to 99.0000 [%] 
[Resolution] 0.0001 
[Remarks] When setting Duty Cycle, Burst Off Length and Burst 

Period are automatically calculated. Also, when Burst On 
Length or Burst Off Length is changed, Duty Cycle is 
automatically calculated. 

 The setting range is automatically calculated according to 
the Common, PHY, MAC parameter settings, so it is not 
always from 0.1000 to 99.0000 [%]. 

 

Burst On Length 

[Function] Displays the burst on length [s]. 
[Display range] Displays the calculated value. 
[Resolution] 0.001 
[Remarks] The calculated result is rounded to a multiple of 

1/Sampling Rate [s]. 
Automatically calculated by PHY/MAC parameter setting. 

 

Burst Off Length 

[Function]  Sets the burst off length [s]. 
[Setting range] The setting range is decided by the maximum and 

minimum values of Duty Cycle and the calculated value 
of Burst On Length. 

[Resolution] 0.001 
[Remarks] When setting Burst Off Length, Duty Cycle and Burst 

Period are automatically  
Also, Burst Off Length is calculated from the values of 
Duty Cycle and Burst On Length as below. 
Burst Off Length=  

Burst On Length × (100.0 – Duty Cycle) / Duty Cycle 
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Burst Period 

[Function] Displays the burst period [s]. 
[Display range] Displays the calculated value. 
[Remarks] The following figure shows the relationships among Duty 

Cycle, Burst On Length, Burst On Length, and Burst 
Period. 

 

 
T1 : Burst On Length 
T2 : Burst Off Length 
T3 : Burst Period 
T1/T3 : Duty Cycle 

 
Repeat Count  

[Function] Sets the repeat count of packet to be transmitted. 
[Default] 1000 
[Setting range] 1 to 65535 
[Remarks] The setting is void if MS269x or MS2830 is selected in the 

Select instrument dialog box. 
 

 
Scramble Initial Value 

[Function] Sets the initial value of scramble processing. 
[Default] 0x5D 
[Setting range] 0x00 to 0x7F 
 

Filter 

Filter Type 

[Function] Sets the filter type.  
[Default] None 
[Setting range] None, Gaussian, Root Nyquist, Nyquist, Ideal 
 

Roll Off/BT 

[Function] Sets the roll-off factor or BT product.  
[Default] 0.50 
[Setting range] 0.01 to 1.00 
[Resolution] 0.01 
[Remarks] The setting is fixed when Filter Type is set to Ideal or 

None. 
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Spectrum shaping 

Windowing Length 

[Function] Sets the windowing length.  
[Default] 8 Sample 
[Setting range] 0 to 32×Oversampling Rate 
[Remarks] The setting range is 0 to 32 when the bandwidth is 160 

MHz. 
 
IEEE 802.11ac 

PPDU Format 

[Function] Displays the PPDU format.  
[Default] VHT 
[Display range] VHT 

 
User Mode 

[Function] Sets the user mode. 
[Default] Single User 
[Setting range] Single User, Multi User 
 
Number of Transmit Chains 

[Function] Sets the number of transmit chain. 
[Default] 1 
[Setting range] 1 to 8  
[Remarks] Number of Transmit Chains cannot be set to equal to or 

under Total Number of Space Time Streams. 
 

Spatial Mapping 

[Function] Sets the spatial mapping. 
[Default] Direct Mapping 
[Setting range] Direct Mapping, Spatial Expansion, Edit Mode  
[Remarks] This function can be used in the following cases:  

Direct Mapping is available only when Number of Space 
Time Streams matches Number of Transmit Chains. 
When Number of Transmit Chains is 1, only Direct 
Mapping is available. 
  

Edit Mode 

[Function] Sets the value of Spatial Mapping Matrix. 
[Setting range] –1.00000–j1.00000 to 1.00000+j1.00000 
[Resolution] The setting resolution is 0.00001 for both real and 

imaginary parts. 
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Spatial Mapping Matrix 

When selecting Spatial Expansion in setting Spatial Mapping, the values 
in Table 3.1.3.2-2 to 3.1.3.2-8 are used in calculation. In this case, by 
using the formula (1) to (28), the stream is expanded from Total Number 
of Space Time Streams to Transmit Chains.  
 
(1) Number of Transmit Chains =2, Total Number of Space Time 

Streams=1 

 T11
2

1

 

(2) Number of Transmit Chains =3, Total Number of Space Time 
Streams=1 

 T111
3

1

 

(3) Number of Transmit Chains =4, Number of Space Time Streams=1 

 T1111
2

1

  

(4) Number of Transmit Chains =5, Total Number of Space Time 
Streams=1 

 T11111
5

1   

(5) Number of Transmit Chains =6, Total Number of Space Time 
Streams=1 

 T111111
6

1  

(6) Number of Transmit Chains =7, Number of Space Time Streams=1 

 T1111111
7

1  

(7) Number of Transmit Chains =8, Total Number of Space Time 
Streams=1 

 T11111111
22

1  

(8) Number of Transmit Chains =3, Total Number of Space Time 
Streams=2 
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(9) Number of Transmit Chains =4, Total Number of Space Time 
Streams=2 
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(10) Number of Transmit Chains =5, Total Number of Space Time 
Streams=2 
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(11) Number of Transmit Chains =6, Total Number of Space Time 
Streams=2 
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(12) Number of Transmit Chains =7, Total Number of Space Time 
Streams=2 
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(13) Number of Transmit Chains =8, Total Number of Space Time 
Streams=2 
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(14) Number of Transmit Chains =4, Total Number of Space Time 
Streams=3 
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(15) Number of Transmit Chains =5, Total Number of Space Time 
Streams=3 
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(16) Number of Transmit Chains =6, Total Number of Space Time 
Streams=3 
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(17) Number of Transmit Chains =7, Total Number of Space Time 
Streams=3 
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(18) Number of Transmit Chains =8, Total Number of Space Time 
Streams=3 
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(19) Number of Transmit Chains =5, Total Number of Space Time 
Streams=4 























0001

1000

0100

0010

0001

5

2

  



 

3.1 Screen Details 

3-25 

3 

N
orm

al S
etu

p S
creen

 

(20) Number of Transmit Chains =6, Total Number of Space Time 
Streams=4 
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(21) Number of Transmit Chains =7, Total Number of Space Time 
Streams=4 
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(22) Number of Transmit Chains =8, Total Number of Space Time 
Streams=4 
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(23) Number of Transmit Chains =6, Total Number of Space Time 
Streams=5 
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(24) Number of Transmit Chains =7, Total Number of Space Time 
Streams=5 
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(25) Number of Transmit Chains =8, Total Number of Space Time 
Streams=5 
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(26) Number of Transmit Chains =7, Total Number of Space Time 
Streams=6 
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(27) Number of Transmit Chains =8, Total Number of Space Time 
Streams=6 
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(28) Number of Transmit Chains =8, Total Number of Space Time 
Streams=7 
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When selecting Edit Mode, a window as Figure 3.1.3.2-1 or 3.1.3.2-2 
appears and allows editing each element. Selecting an element on the 
matrix displays Input Complex Data window and allows entering 
numerical values. The number of the elements on the matrix and their 
defaults depend on Number of Transmit Chains.   
(Refer to Table 3.1.3.2-1 to 3.1.3.2-8.) 

 

 

Figure 3.1.3.2-1  Spatial Mapping Matrix Setting Window (Number of Transmit 

Chains= 2) 

 

 

Figure 3.1.3.2-2  Spatial Mapping Matrix Setting Window (Number of Transmit 

Chains= 8) 

 

 

 

Figure 3.1.3.2-3  Input Complex Data Window 
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Table 3.1.3.2-1  Relationship between Number of Transmit Chains and 

the Displayed Element Count 

Number of Transmit 
Chains 

Displayed Element Count

2 2 × 2 matrix 
3 3 × 3 matrix 
4 4 × 4 matrix 
5 5 × 5 matrix 
6 6 × 6 matrix 
7 7 × 7 matrix 
8 8 × 8 matrix 

 

Table 3.1.3.2-2  Default of elements when Number of Transmit Chains =2 

 Spatial Stream 1 Spatial Stream 2 

Transmit Chain 1 0.70711 0.70711 

Transmit Chain 2 0.70711 -0.70711 

 

Table 3.1.3.2-3  Default of elements when Number of Transmit Chains =3 

 Spatial Stream 1 Spatial Stream 2 Spatial Stream 3

Transmit Chain 1 0.57735 0.57735 0.57735 

Transmit Chain 2 0.57735 
-0.28868 
+ j 0.5 

-0.28868 
- j 0.5 

Transmit Chain 3 0.57735 
-0.28868 

- j 0.5 
-0.28868 
+ j 0.5 

 

Table 3.1.3.2-4  Default of elements when Number of Transmit Chains =4 

 Spatial Stream 1 Spatial Stream 2 Spatial Stream 3 Spatial Stream 4

Transmit Chain 1 0.5 0.5 0.5 0.5 

Transmit Chain 2 0.5 j 0.5 -0.5 -j 0.5 

Transmit Chain 3 0.5 -0.5 0.5 -0.5 

Transmit Chain 4 0.5 -j 0.5 -0.5 j 0.5 
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Table 3.1.3.2-5  Default of elements when Number of Transmit Chains =5 

 Spatial Stream 1 Spatial Stream 2 Spatial Stream 3 Spatial Stream 4 Spatial Stream 5

Transmit Chain 1 0.44721 0.44721 0.44721 0.44721 0.44721 

Transmit Chain 2 0.44721 
0.13820 

+ j 0.42533 
-0.36180 

+ j 0.26287 
-0.36180 

- j 0.26287 
0.13820 

- j 0.42533 

Transmit Chain 3 0.44721 
-0.36180 

+ j 0.26287 
0.13820 

- j 0.42533 
0.13820 

+ j 0.42533 
-0.36180 

- j 0.26287 

Transmit Chain 4 0.44721 
-0.36180 

- j 0.26287 
0.13820 

+ j 0.42533 
0.13820 

- j 0.42533 
-0.36180 

+ j 0.26287 

Transmit Chain 5 0.44721 
0.13820 

- j 0.42533 
-0.36180 

- j 0.26287 
-0.36180 

+ j 0.26287 
0.13820 

+ j 0.42533 

 

Table 3.1.3.2-6  Default of elements when Number of Transmit Chains =6 

 Spatial 

Stream 1 

Spatial 

Stream 2 

Spatial 

Stream 3 

Spatial 

Stream 4 

Spatial 

Stream 5 

Spatial 

Stream 6 

Transmit Chain 1 0.40825 0.40825 0.40825 0.40825 0.40825 0.40825 

Transmit Chain 2 0.40825 
0.20412 

+ j 0.35355
-0.20412 

+ j 0.35355 -0.40825 
-0.20412 

- j 0.35355 
0.20412 

- j 0.35355

Transmit Chain 3 0.40825 
-0.20412 

+ j 0.35355
-0.20412 

- j 0.35355 0.408248 
-0.20412 

+ j 0.35355 
-0.20412 

- j 0.35355

Transmit Chain 4 0.40825 -0.40825 0.40825 -0.40825 0.40825 -0.40825 

Transmit Chain 5 0.40825 
-0.20412 

- j 0.35355
-0.20412 

+ j 0.35355 0.408248 
-0.20412 

- j 0.35355 
-0.20412 

+ j 0.35355

Transmit Chain 6 0.40825 
0.20412 

- j 0.35355
-0.20412 

- j 0.35355
-0.40825 

-0.20412 
+ j 0.35355 

0.20412 
+ j 0.35355
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Table 3.1.3.2-7  Default of elements when Number of Transmit Chains =7 

 Spatial 

Stream 1 

Spatial 

Stream 2 

Spatial 

Stream 3 

Spatial 

Stream 4 

Spatial 

Stream 5 

Spatial 

Stream 6 

Spatial 

Stream 7 

Transmit 

Chain 1 
0.37796 0.37796 0.37796 0.37796 0.37796 0.37796 0.37796 

Transmit 

Chain 2 
0.37796 

0.23566 
+ j 0.29550 

-0.08411 
+ j 0.36849

-0.34053 
+ j 0.16399

-0.34053 
- j 0.16399

-0.08411 
- j 0.36849 

0.23566 
- j 0.29550;

Transmit 

Chain 3 
0.37796 

-0.08411 
+ j 0.36849 

-0.34053 
- j 0.16399

0.23566 
- j 0.29550

0.23566 
+ j 0.29550

-0.34053 
+j 0.16399 

-0.08411 
- j 0.36849

Transmit 

Chain 4 
0.37796 

-0.34053 
+ j 0.16399 

0.23566 
- j 0.29550

-0.08411 
+ j 0.36849

-0.08411 
- j 0.36849

0.23566 
+ j 0.29550 

-0.34053 
- j 0.16399

Transmit 

Chain 5 
0.37796 

-0.34053 
- j 0.16399 

0.23566 
+ j 0.29550

-0.08411 
- j 0.36849

-0.08411 
+ j 0.36849

0.23566 
- j 0.29550 

-0.34053 
+ j 0.16399

Transmit 

Chain 6 
0.37796 

-0.08411 
- j 0.36849 

-0.34053 
+ j 0.16399

0.23566 
+ j 0.29550

0.23566 
- j 0.29550

-0.34053 
- j 0.16399 

-0.08411 
+ j 0.36849

Transmit 

Chain 7 
0.37796 

0.23566 
- j 0.29550 

-0.08411 
- j 0.36849

-0.34053 
- j 0.16399

-0.34053 
+ j 0.16399

-0.08411 
+ j 0.36849 

0.23566 
+ j 0.29550

 

Table 3.1.3.2-8  Default of elements when Number of Transmit Chains =8 

 Spatial 

Stream 1 

Spatial 

Stream 2 

Spatial 

Stream 3

Spatial 

Stream 4

Spatial 

Stream 5

Spatial 

Stream 6 

Spatial 

Stream 7 

Spatial 

Stream 8

Transmit 

Chain 1 
0.35355 0.35355 0.35355 0.35355 0.35355 0.35355 0.35355 0.35355

Transmit 

Chain 2 
0.35355 

0.25 
+ j 0.25 

j 0.35355
-0.25 

+ j 0.25 
-0.35355

-0.25 
- j 0.25 

- j 0.35355 0.25- j 0.25

Transmit 

Chain 3 
0.35355 j 0.35355 -0.35355 - j 0.35355 0.353553 j 0.35355 -0.35355 - j 0.35355

Transmit 

Chain 4 
0.35355 

-0.25 
+ j 0.25 

- j 0.35355
0.25 

+ j 0.25 
-0.35355

0.25 
- j 0.25 

j 0.35355 
-0.25 

- j 0.25 

Transmit 

Chain 5 
0.35355 -0.35355 0.353553 -0.35355 0.353553 -0.35355 0.35355 -0.35355

Transmit 

Chain 6 
0.35355 

-0.25 
- j 0.25 

j 0.35355
0.25 

- j 0.25 
-0.35355

0.25 
+ j 0.25 

- j 0.35355 
-0.25 

+ j 0.25 

Transmit 

Chain 7 
0.35355 -0.35355 -0.35355 j 0.35355 0.353553 - j 0.35355 -0.35355 j 0.35355

Transmit 

Chain 8 
0.35355 

0.25 
- j 0.25 

- j 0.35355
-0.25 

- j 0.25 
-0.35355

-0.25 
+ j 0.25 

j 0.35355 
0.25 

+ j 0.25 
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GI 

[Function] Sets the guard interval. 
[Default] Long 
[Setting range] Short, Long 
 
Total Number of Space Time Streams 
[Function] Displays the total number of space time stream.  
[Default] 1 
[Display range]  1 to 8 
[Remarks] Displays the total number of space time streams under 

each User# 
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3.1.4 PHY/MAC parameters 
The items displayed in the PHY/MAC parameter list are described below.  

3.1.4.1 PHY parameters(System = other than 11ac) 

When MPDU or A-MPDU is selected in the tree view, the following items 
are displayed in the PHY/MAC parameter list.  
All PHY parameter values are the same for MPDU and A-MPDU.  

PPDU Format 

[Function] Sets the PPDU format.  
[Default] HT Mixed 
[Setting range] Non-HT, HT Mixed, HT Greenfield 
[Remarks] This function can be used in the following case: 

 System = 11n 
 
MCS 

[Function]  Sets the MCS.  
[Default] 7 
[Setting range] 0 to 76 
[Remarks] Available in the following conditions:  

System=11n and PPDU Format=HT Mixed/HT Greenfield, 
Or system=11ac.  
Details about the parameters when MCS is set are 
defined in IEEE Std 802.11n-2009 20.6.  

 
Number of Spatial Streams 

[Function]  Displays the Number of Spatial Streams.  
[Default] 1 
[Display range] 1 to 4 

[Remarks] Available in the following conditions:  
 System=11n and PPDU Format=HT Mixed/HT Greenfield 
 The displayed value varies according to MCS.  
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High Rate Modulation 

[Function]  Sets the modulation scheme during direct diffusion.  
[Default] CCK 
[Setting range] CCK, PBCC 
[Remarks] Available in the following conditions:  

 System=11b 
System=11g, and Frame Format=ERP-CCK/ERP-PBCC 
 CCK/PBCC is selectable when Data Rate=5.5 Mbps/11 
Mbps.  
Note that Frame Format is automatically set to: 
ERP-CCK when High Rate Modulation is CCK. 
ERP-PBCC when High Rate Modulation is PBCC.  
Only PBCC can be set when Data Rate=22 Mbps/33 
Mbps. 
 

Modulation 

[Function] Displays the PSDU modulation scheme. 
[Default] The default value for each System is as follows:  

 System=11a, 11g, 11j, 11p,11n (PPDU Format=Non-HT): 
64QAM 

[Display range] BPSK, QPSK, 16QAM, 64QAM, DBPSK, DQPSK 
[Remarks] This is not available when System=11b and Data 

Rate=5.5, or, System=11g and Data Rate=5.5, 11, 22, 33 
Mbps 

  This is not available when System=11n and PPDU 
Format=HT Mixed/HT Greenfield 

  
Code Rate 

[Function]  Displays the code rate.  
[Default] 3/4 
[Setting range] 1/2, 2/3, 3/4, 5/6 
[Remarks]  This is not available when System=11b or System=11g, 

and Data Rate=1, 2, 5.5, 11, 22, 33 Mbps.  
 Display only when System=11n and PPDU Format=HT 

Mixed/HT Greenfield 
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Data Rate 

[Function]  Sets the data rate.  
[Default] The default value for each System is as follows:  
 System=11a, 11g, 11j: 54 Mbps 
  System=11b: 11 Mbps 
  System=11p: 27 Mbps 
[Setting range] 1, 2, 3, 4.5, 5.5, 6, 9, 11, 12, 18, 22, 24, 27, 33, 36, 48, 54 
[Remarks]  This setting is not available in the following conditions: 

 System=11n and PPDU Format=HT Mixed/HT Greenfield 
When System=11n and PPDU format=Non-HT,  
the setting range is the same as System=11a.  
 

Table 3.1.4.1-1  Available options when System=11a, 11j 

Data Rate Frame 
Format 

Modulation High Rate 
Modulation 

Code 
Rate 

6 Mbps 

N/A 

BPSK 

N/A 

1/2 
9 Mbps BPSK 3/4 
12 Mbps QPSK 1/2 
18 Mbps QPSK 3/4 
24 Mbps 16QAM 1/2 
36 Mbps 16QAM 3/4 
48 Mbps 64QAM 2/3 
54 Mbps 64QAM 3/4 

 
Table 3.1.4.1-2  Available options when System=11b 

Data Rate Frame 
Format 

Modulatio
n 

High Rate 
Modulation 

Code 
Rate 

1 Mbps 

N/A 

DBPSK N/A 

N/A 
2 Mbps DQPSK N/A 
5.5 Mbps N/A CCK, PBCC 
11 Mbps N/A CCK, PBCC 
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Table 3.1.4.1-3  Available options when System=11g 

Data 
Rate 

Frame 
Format 

Modulation High Rate 
Modulation 

Code 
Rate 

1 Mbps ERP-DSSS DBPSK N/A N/A 
2 Mbps ERP-DSSS DQPSK N/A N/A 
5.5 Mbps ERP-CCK 

ERP-PBCC 
N/A CCK, PBCC N/A 

6 Mbps ERP-OFDM, 
DSSS-OFDM 

BPSK N/A 1/2 

9 Mbps ERP-OFDM, 
DSSS-OFDM 

BPSK N/A 3/4 

11 Mbps ERP-CCK 
ERP-PBCC 

N/A CCK, PBCC N/A 

12 Mbps ERP-OFDM, 
DSSS-OFDM 

QPSK N/A 1/2 

18 Mbps ERP-OFDM, 
DSSS-OFDM 

QPSK N/A 3/4 

22 Mbps ERP-PBCC N/A PBCC N/A 
24 Mbps ERP-OFDM, 

DSSS-OFDM 
16QAM N/A 1/2 

33 Mbps ERP-PBCC N/A PBCC N/A 
36 Mbps ERP-OFDM, 

DSSS-OFDM 
16QAM N/A 3/4 

48 Mbps ERP-OFDM, 
DSSS-OFDM 

64QAM N/A 2/3 

54 Mbps ERP-OFDM, 
DSSS-OFDM 

64QAM N/A 3/4 
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Table 3.1.4.1-4  Available options when System=11p 

Data Rate Frame 
Format 

Modulation High Rate 
Modulation 

Code 
Rate 

3 Mbps 

N/A 

BPSK 

N/A 

1/2 
4.5 Mbps BPSK 3/4 
6 Mbps QPSK 1/2 
9 Mbps QPSK 3/4 
12 Mbps 16QAM 1/2 
18 Mbps 16QAM 3/4 
24 Mbps 64QAM 2/3 
27 Mbps 64QAM 3/4 

 
Preamble Type 

[Function]  Sets the preamble type. 
[Default] Long 
[Setting range] Long, Short 
[Remarks] Available in the following conditions:  

 System=11b 
 System=11g 
 Only Long can be set when System=11g, and Frame 
Format=ERP-DSSS, and Data Rate=1 Mbps.  
Only Long can be set when System=11g, and Frame 
Format=ERP-OFDM.  
 Only Long can be set when System=11b, and Data Rate=1 
Mbps.  
 

Frame Format 

[Function] Sets the secondary modulation scheme of the header and 
payload.  

[Default] ERP-OFDM 
[Setting range] ERP-OFDM, DSSS-OFDM, ERP-DSSS, ERP-CCK, 

ERP-PBCC 
[Remarks] Available in the following conditions:  

 System=11g 
Note that Frame Format is automatically set to: 
ERP-CCK when High Rate Modulation is CCK. 
ERP-PBCC when High Rate Modulation is PBCC.  
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Spatial Mapping 

[Function] Sets the spatial mapping mode.  
[Default] Direct Mapping 
[Setting range] Direct Mapping, Spatial Expansion, Edit Mode  
[Remarks] Available in the following conditions:  

 System=11n and PPDU Format=HT Mixed/HT Greenfield 
Direct Mapping is available only when: Number of Space 
Time Streams=Number of Transmit Chains 
Direct Mapping can be set only when: Number of 
Transmit Chains=1 
  

Edit Mode 

[Function] Sets Spatial Mapping Matrix.  
[Setting range] –1.00000 – j1.00000 to 1.00000 + j1.00000 
[Resolution] The setting resolution is 0.00001 for both real and 

imaginary parts. 
 

Spatial Mapping Matrix 

If Spatial Expansion is selected for Spatial Mapping, the values shown in 
Figures 3.1.4.1-1 to 3.1.4.1-3 are applied for calculation. In this case, the 
stream is extended from Space Time Streams to Transmit Chains by 
using expressions (1) to (6).  
 
(1) Number of Transmit Chains =2, Number of Space Time Streams=1 

 T11
2

1

 

(2) Number of Transmit Chains =3, Number of Space Time Streams=1 
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(3) Number of Transmit Chains =4, Number of Space Time Streams=1 
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(4) Number of Transmit Chains =3, Number of Space Time Streams=2 
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(5) Number of Transmit Chains =4, Number of Space Time Streams=2 
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(6) Number of Transmit Chains =4, Number of Space Time Streams=3 
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If Edit Mode is selected for Spatial Mapping, one of the Spatial Mapping 
Matrix windows shown in Figures 3.1.4.1-1 to 3.1.4.1-3 is displayed, on 
which the spatial mapping can be edited. Selecting an element on the 
matrix displays the Input Complex Data window shown in Figure 
3.1.4.1-4, on which numerical values can be entered. The number of 
elements on the matrix depends on the value set for Number of Transmit 
Chains. Refer to Table 3.1.4.1-5. 
 

  

Figure 3.1.4.1-1  Spatial Mapping Matrix setting window (Number of 

Transmit Chains= 2) 

  

Figure 3.1.4.1-2  Spatial Mapping Matrix setting window (Number of 

Transmit Chains= 3) 

 

 

Figure 3.1.4.1-3  Spatial Mapping Matrix setting window (Number of 

Transmit Chains= 4) 
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Figure 3.1.4.1-4  Input Complex Data window 

 
Table 3.1.4.1-5  Relationship between Number of Transmit Chains and 

the Displayed Element Count 

Number of Transmit Chains Displayed Element Count

1 Does not display 
2 2 × 2 matrix 
3 3 × 3 matrix 
4 4 × 4 matrix 

 

GI 

[Function] Sets the guard interval.  
[Default] Long 
[Setting range] Short, Long 
[Remarks] Available in the following conditions:  

 System=11n and PPDU Format=HT Mixed/HT Greenfield 
 

Smoothing 

[Function] Enables/disables smoothing processing.  
[Default] Off 
[Setting range] On, Off 
[Remarks] Available in the following conditions:  

 System=11n and PPDU Format=HT Mixed/HT Greenfield 
 

Not Sounding 

[Function] Enables/disables Not Sounding processing.  
[Default] On 
[Setting range] On, Off 
[Remarks] Available in the following conditions:  

 System=11n and PPDU Format=HT Mixed/HT Greenfield 
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Number of Transmit Chains 

[Function] Sets Number of Transmit Chains.  
[Default] 1 
[Setting range] 1 to 4 
[Remarks] Available in the following conditions:  

 System=11n and PPDU Format=HT Mixed/HT Greenfield 
A value equal to or greater than that set for Number of 
Space Time Streams can be set for Number of Transmit 
Chains.  
 

Number of Space Time Streams 

[Function] Sets the number of space time streams.  
[Default] 1 
[Setting range] 1 to 4 
[Remarks] Available in the following conditions:  

 System=11n and PPDU Format=HT Mixed/HT Greenfield 
A value equal to or greater than that set for Number of 
Spatial Streams can be set for Number of Space Time 
Streams.  

 
Number of Extension Spatial Streams 

[Function] Sets Number of Extension Spatial Streams.  
[Default] 0 
[Setting range] 0 to (Number of Transmit Chains – Number of Space 

Time Streams) 
[Remarks] Available in the following conditions:  

 System=11n and PPDU Format=HT Mixed/HT Greenfield 
 

Half Bandwidth 

[Function] Sets the carrier arrangement when Bandwidth = 40 MHz.  
[Default] N/A 
[Setting range] Lower Mode, Upper Mode, N/A 
[Remarks]  This is available only when System=11n and 

Bandwidth=40 MHz. Only N/A can be set when in 
MCS32.  
Only the lower 20 MHz of a 40 MHz channel is 
transmitted when Lower Mode is specified, while only the 
upper 20 MHz of a 40 MHz channel is transmitted when 
Upper Mode is specified. N/A transmits 40 MHz channel 
as is.  
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3.1.4.2 MAC parameters(System = other than 11ac) 

When MPDU or A-MPDU is selected in the tree view, the following items 
are displayed in the PHY/MAC parameter list. MAC parameter settings 
can be different between MPDU and A-MPDU.  

Data Length 

[Function]  Sets the data wavelength.  
[Default] The default value for each System is as follows:  
  System=11a, 11g (Frame Format=DSSS-OFDM, 

ERP-OFDM), 11j, 11p: 
966 [octet(s)] 

 System=11b, 11g (Frame Format=ERP-DSSS, ERP-PBCC, 
ERP-CCK): 
990 [octet(s)] 

  System=11n: 
4062 [octet(s)] 

 System=11n and PPDU Format=Non-HT:  
 4061 [octet(s)] 
 System=11n and  

PPDU Format=HT Mixed/HT Greenfield:  
 4062 [octet(s)] 
[Setting range] The setting range for each system is as follows: 
 System=11a, 11b, 11g, 11j, 11p, or System=11n and PPDU 

format=Non-HT: 
1 to (4095–Diff) 

 When System=11n, and PPDU Format=HT Mixed/HT 
Greenfield: 
1 to (65535–Diff) 

[Remarks] Diff refers to a value (octets) obtained by subtracting the 
value of Total Length (MAC header + FCS) from the total 
number of MAC parameters that are set to Off in the 
MAC Frame Format setting window.  

  Total Length=40 [octet(s)] 
  



 

Chapter 3  Normal Setup Screen 

3-42 

MPDU Length 

[Function]  Displays the MPDU length.  
[Default] The default value for each System is as follows:  
  System=11a, 11g (Frame Format=DSSS-OFDM, 

ERP-OFDM), 11j, 11n, 11p: 
1000 [octet(s)] 

 System=11b, 11g (Frame Format=ERP-DSSS, ERP-PBCC, 
ERP-CCK): 
1024 [octet(s)] 
System=11n and PPDU Format=Non-HT:  
4095 [octet(s)] 
System=11n and  
PPDU Format=HT Mixed/HT Greenfield:  
4096 [octet(s)] 

[Display range] The display range for each system is as follows: 
 System=11a, 11b, 11g, 11j, 11p, or System=11n and PPDU 

format=Non-HT: 
(Diff+1) to 4095 
 When System=11n, and PPDU Format=HT Mixed/HT 
Greenfield: 
(Diff+1) to 65535 
When System=11n, and A-MPDU=ON: (Diff+1) to 4095 

 
MAC Frame Type 

[Function]  Sets the MAC Frame type.  
[Default] General 
[Remarks] MAC information can be set.  
 

 

 

Figure 3.1.4.2-1  MAC Frame Format setting window (when System = 

11n) 
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MAC Data Type 

[Function] Sets the type of data assigned to the MAC frame body.  

[Default] PN9fix 
[Setting range] PN9fix, PN15fix, 16bit repeat, User File 

 
Data Type Repeat Data 

[Function]  Sets 16-bit data to be assigned to the MAC frame body.  
[Default] 0x0000 
[Setting range] 0x0000 to 0xFFFF 
[Remarks] This parameter is displayed only when 16 bit repeat is 

selected for MAC Data Type. 

 
Data Type User File 

[Function] Sets a user file to be assigned to the MAC frame body.  
[Setting range] Any file can be selected. 
[Remarks] This parameter is displayed only when User File is 

selected for MAC Data Type.  
Refer to Appendix B “User File Format” for details on the 
user file format.  

 
Frame Control 

[Function]  Sets the Frame Control.  
[Default] 0x0800 
[Setting range] 0x0000 to 0xFFFF 
 
Duration/ID 

[Function]  Sets the Duration/ID.  
[Default] 0x0000 
[Setting range] 0x0000 to 0xFFFF 
 
Address1 

[Function]  Sets the Address1.  
[Default] 0xFFFF FFFF FFFF 
[Setting range] 0x0000 0000 0000 to 0xFFFF FFFF FFFF 
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Address2 

[Function]  Sets the Address2.  
[Default] 0x2022 2222 2202 
[Setting range] 0x0000 0000 0000 to 0xFFFF FFFF FFFF 
[Remarks] Available in the following condition: 

 System=11n and Address2 SW = On. 
 

Address2 SW 

[Function]  Enables/disables the MAC Address2. 
[Default] On 
[Setting range] On, Off 
 

Address3 

[Function]  Sets the Address3.  
[Default] 0x5055 5555 5505 
[Setting range] 0x0000 0000 0000 to 0xFFFF FFFF FFFF 
[Remarks] Available in the following condition: 

 System=11n and Address3 SW = On.  
 
Address3 SW 

[Function]  Enables/disables the MAC Address3. 
[Default] On 
[Setting range] On, Off 
 

Sequence Control 

[Function]  Sets the Sequence Control.  
[Default] 0x0000 
[Setting range] 0x0000 to 0xFFFF 
[Remarks] Available in the following condition: 

 System=11n and Sequence Control SW = On.  
 
Sequence Control SW 

[Function]  Enables/disables the Sequence Control. 
[Default] On 
[Setting range] On, Off 
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Address4 

[Function]  Sets the Address4.  
[Default] 0x644D 2003 0000 
[Setting range] 0x0000 0000 0000 to 0xFFFF FFFF FFFF 
[Remarks] Available in the following condition: 

 System=11n and Address4 SW=On.  
 
Address4 SW 

[Function]  Enables/disables the MAC Address4. 
[Default] On 
[Setting range] On, Off 
  
QoS Control 

[Function]  Sets the QoS Control.  
[Default] 0x0000 
[Setting range] 0x0000 to 0xFFFF 
[Remarks] Available in the following condition: 

 System=11n and QoS Control SW=On.  
 
QoS Control SW 

[Function]  Enables/disables the QoS Control. 
[Default] Off 
[Setting range] On, Off 
[Remarks] Available in the following condition: 

System=11n 
 
HT Control 

[Function] Sets the HT Control.  
[Default] 0x0000 0000 
[Setting range] 0x0000 0000 to 0xFFFF FFFF 
[Remarks] Available in the following condition: 

System=11n and HT Control SW=On.  
 
HT Control SW 

[Function] Enables/disables the HT Control. 
[Default] Off 
[Setting range] On, Off 
[Remarks] Available in the following condition: 

System=11n 
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MAC FCS 

[Function] Enables/disables the MAC FCS.  
[Default] On 
[Setting range] On, Off 
 
Increment Sequence Number 

[Function] Enables/disables the Increment Sequence Number.  
[Default] Off 
[Setting range] On, Off 
[Remarks] If set to On, the count-up operation starts from the upper 

12 bits of the value specified for Sequence Control, 
incrementally at each interval specified by Sequence 
Number Increment Period.  

 
Sequence Number Increment Period 

[Function] Sets the interval to count up the sequence number.  
[Default] 1 
[Setting range] 1 to 15 
[Remarks] This is available when Increment Sequence Number or 

Increment Fragment Number is set to On.  
 
Increment Fragment Number 

[Function] Enables/disables the Increment Fragment Number.  
[Default] Off 
[Setting range] On, Off 
[Remarks] If set to On, the count-up operation starts from the lower 

4 bits of the value specified for Sequence Control, 
incrementally for each packet at each interval specified by 
Sequence Number Increment Period.  
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3.1.4.3 PHY parameter (System=11ac) 

 

When MPDU or A-MPDU under User# is selected in the tree view, the 
following items are displayed in the PHY/MAC parameter list. 
All PHY parameter values for each User# are the same for MPDU and 
A-MPDU. 

Scramble 

[Function] Enables/disables scramble processing. 
[Default] On 
[Setting range] On, Off 
 
MCS 

[Function]  Sets the MCS. 
[Default] 8 
[Setting range] 0 to 9 
[Remarks] The setting range of MCS changes depending on the 

setting of Bandwidth, Number of Spatial Streams.  

 Details about the parameters when MCS is set are 
defined in IEEE P802.11ac/D2.0, January 2012 22.5. 

 
Number of Spatial Streams 

[Function]  Sets the number of spatial streams.  
[Default] 1 
[Setting range]  1 to 8  
[Remarks] The setting range is 1 to 4 when the user mode is Multi 

User. 
 

Modulation 

[Function] Displays the modulation scheme of PSDU. 
[Default] 256QAM 
[Display range] BPSK, QPSK, 16QAM, 64QAM, 256QAM 
[Remarks] The value depends on MCS. 
 
Code Rate 

[Function]  Displays the code rate. 
[Default] 3/4 
[Display range] 1/2, 2/3, 3/4, 5/6 
[Remarks]  The value depends on MCS. 
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Coding 

[Function] Sets of the coding is On or Off. 
[Setting range] On 
[Remarks]  Fixed to On for System=11ac. 
 
Coding Mode 

[Function] Sets the coding mode.  
[Setting range] BCC 
[Remarks] Fixed to BCC for System=11ac. 
 
BCC Interleaver 

[Function] Enables/disables BCC Interleaver.  
[Setting range] On 
[Remarks] Fixed to On for System=11ac. 
 
LDPC Tone Mapper 

[Function] Enables/disables .  
[Default] On 
[Setting range] On, Off 
[Remarks] Void for System=11ac. 

 
Number of Space Time Streams 
[Function] Sets the number of space time stream.  
[Default] 1 
[Setting range] The same value as Number of Spatial Stream, 

Number of Spatial Stream×2 
[Remarks]  Number of Spatial Streams×2 is settable only when 

Number of Spatial Streams×2 ≤ Number of Transmit 
Chains. 
When the user mode is set to Multi User, Number of 
Spatial Streams×2 is not settable unless Number of 
Spatial Streams ≤ 2 for each User#. 
 

Group ID 

[Function] Sets the group ID.  
[Default] 0x3F (User Mode = Single User) 

 0x01 (User Mode = Multi User) 
[Setting range] 0x00, 0x3F (User Mode = Single User) 

 0x01 to 0x3E (User Mode = Multi User) 
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Partial AID 

[Function] Sets Partial AID. 
[Default] 0x000 
[Setting range] 0x000 to 0x1FF  
[Remarks]  Void when User Mode = Multi User. 
 
TXOP PS NOT ALLOWED 

[Function] Sets TXOP PS NOT ALLOWED. 
[Default] 1 
[Setting range] 0, 1 
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3.1.4.4 MAC parameter (System=11ac) 

When MPDU or A-MPDU under User# is selected in the tree view, the 
following items are displayed in the PHY/MAC parameter list. 
All PHY parameter values for each User# are the same for MPDU and 
A-MPDU.  

A-MPDU 
[Function] Enables/disables A-MPDU for each User#. 
[Default] Off 
[Setting range] On, Off 
[Remarks] If A-MPDU is set to Off in one A-MPDU#, all 

MPDU/A-MPDU# under other User#s are all set to Off. 
 

Data Length 

[Function]  Set the data length. 
[Default]  4062 [octet(s)] 
[Setting range]  1 to (65535–Diff) (A-MPDU=Off) 
  1 to (16384–Diff) (A-MPDU=On) 
[Remarks] Diff=Total Length(Mac Header+FCS) 

–(Sum of MAC parameters [octet(s)] that are Off on 
MAC Frame Format setting window.) 

Total Length=40 [octet(s)] 
 When Oversampling Ratio=8, Bandwidth=20 MHz, 
MCS=0, Number of Spatial Streams=1, A-MPDU=Off:  
1 to (42500–Diff) 
When the setting range is changed from 1 to (65535–Diff) 
to 1 to (42500–Diff), the setting of MAC parameter are 
automatically initialized.  
 

MPDU Length 

[Function]  Displays the MPDU length. 
[Default] 4096 [octet(s)] 
[Display range]  (Diff+1) to 65535 (A-MPDU=Off) 

(Diff+1) to 16384 (A-MPDU=On) 
[Remarks] When Oversampling Ratio=8, Bandwidth=20 MHz, 

MCS=0, Number of Spatial Streams=1, A-MPDU=Off:  
(Diff+1) to 42500 
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Total A-MPDU Length 
[Function] Displays the total A-MPDU Length directly under each 

User#. 
[Display range] 1 to 262140 
[Remarks] Void when A-MPDU is Off. 
 When Oversampling Ratio=8, Bandwidth=20 MHz, 

MCS=0, Number of Spatial Streams=1:  
1 to 42500 

 
MAC Frame Type 

[Function] Sets the type of MAC Frame. 
[Default] General 
[Remarks] Sets the MAC information. 
 

 

 

Figure 3.1.4.4-1  MAC Frame Format setting window (System = 11ac) 

 
MAC Data Type 

[Function] Sets the data type to be inserted into Mac Frame body. 
[Default] PN9fix 
[Setting range] PN9fix, PN15fix, 16bit repeat, User File 

 
Data Type Repeat Data 

[Function] Sets the 16 bit data to be inserted into Mac Frame body. 
[Default] 0x0000 
[Setting range] 0x0000 to 0xFFFF 
[Remarks] This parameter is displayed only when 16 bit repeat is 

selected for MAC Data Type. 
 
Data Type User File 

[Function] Sets the user file to be inserted into Mac Frame body. 
[Setting range] Any file can be selected. 
[Remarks] This parameter is displayed only when User File is 

selected for MAC Data Type. 
Refer to Appendix B “User File Format” for details on the 
user file format. 
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Frame Control 

[Function] Sets the frame control. 
[Default] 0x0800 
[Setting range] 0x0000 to 0xFFFF 
 
Duration/ID 

[Function] Sets Duration/ID. 
[Default] 0x0000 
[Setting range] 0x0000 to 0xFFFF 
 
Address1 

[Function] Sets MAC Address1. 
[Default] 0xFFFF FFFF FFFF 
[Setting range] 0x0000 0000 0000 to 0xFFFF FFFF FFFF 

 
Address2 

[Function] Sets MAC Address2. 
[Default] 0x2022 2222 2202 
[Setting range] 0x0000 0000 0000 to 0xFFFF FFFF FFFF 
[Remarks] Available in the following condition: 

 Address2 SW = On 
 

Address2 SW 

[Function] Enables/disables MAC Address2. 
[Default] On 
[Setting range] On, Off 

 
Address3 

[Function] Sets MAC Address3. 
[Default] 0x5055 5555 5505 
[Setting range] 0x0000 0000 0000 to 0xFFFF FFFF FFFF 
[Remarks] Available in the following condition: 

 Address3 SW = On 
 
Address3 SW 

[Function] Enables/disables MAC Address3. 
[Default] On 
[Setting range] On, Off 
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Sequence Control 

[Function] Sets the Sequence Control. 
[Default] 0x0000 
[Setting range] 0x0000 to 0xFFFF 
[Remarks] Available in the following condition: 

 Sequence Control SW = On 
 

Sequence Control SW 

[Function] Enables/disables the Sequence Control. 
[Default] On 
[Setting range] On, Off 
 
Address4 

[Function] Sets MAC Address4. 
[Default] 0x644D 2003 0000 
[Setting range] 0x0000 0000 0000 to 0xFFFF FFFF FFFF 
[Remarks] Available in the following condition: 

 Address4 SW = On 
 
Address4 SW 

[Function] Enables/disables MAC Address4. 
[Default] On 
[Setting range] On, Off 
  
QoS Control 

[Function] Sets the QoS Control. 
[Default] 0x0000 
[Setting range] 0x0000 to 0xFFFF 
[Remarks] Available in the following condition: 

 QoS Control SW = On 
 
QoS Control SW 

[Function] Enables/disables the QoS Control. 
[Default] Off 
[Setting range] On, Off 
 
HT Control 

[Function] Sets the HT Control. 
[Default] 0x0000 0000 
[Setting range] 0x0000 0000 to 0xFFFF FFFF 
[Remarks] Available in the following condition: 

 HT Control SW = On 
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HT Control SW  

[Function]  Enables/disables the HT Control. 
[Default] Off 
[Setting range] On, Off 
 
MAC FCS 

[Function]  Enables/disables the MAC FCS. 
[Default] On 
[Setting range] On, Off 
 
Increment Sequence Number 

[Function] Enables/disables the Increment of Sequence Number. 
[Default] Off 
[Setting range] On, Off 
[Remarks] If the Increment of Sequence Number sets to On, the 

count-up operation starts from the upper 12 bits of the 
value specified for Sequence Control, incrementally at 
each interval specified by Sequence Number Increment 
Period.  

 

Sequence Number Increment Period 

[Function] Sets the interval to count up the sequence number.  
[Default] 1 
[Setting range] 1 to 15 
[Remarks] This is available when Increment Sequence Number or 

Increment Fragment Number is set to On. 
 

 
Increment Fragment Number 

[Function] Enables/disables the Increment Fragment Number. 
[Default] Off 
[Setting range] On, Off 
[Remarks] If Increment Fragment Number sets to On, the count-up 

operation starts from the lower 4 bits of the value 
specified for Sequence Control, incrementally for each 
frame at each interval specified by Sequence Number 
Increment Period. 
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3.1.5 Export File screen 
When “Calculation” is selected from the Edit menu or the   tool 
button is clicked on the main screen, the Export File screen is displayed.  
The Export File screen is displayed when generating a waveform pattern.  
In this screen, the output destination folder, package name, file name, 
and comment for the waveform pattern to be generated can be specified.  

When MG3710 or MG3700 is selected in the Select instrument screen, 
the Package (Combination File) box is displayed as well. 
 
When the system is 11ac and the bandwidth is other than 80+80 MHz, 
the waveform files as many as the specified antenna number are 
generated.  
If the antenna number is 2 or more, the file to be generated has an 
underscore and antenna number at its name end as “Tx_Antenna_0”.  
When the system is 11ac and the bandwidth is 80+80 MHz, “Low” is 
added to the end of the waveform file name of SG1 and “Up” to that of 
SG2. 

Note: 

The number of waveform patterns (Antenna Port items) to be 
generated and the Export File screen change depending on the setting 
of Number of Antennas. See Figures 3.1.5-1 to 3.1.5-6. 

Note:  

When launching IQproducer on the MG3710, the Package 
(Combination File) box (shown in Figures 3.1.5-1 and 3.1.5-3—3.1.5-6) 
is displayed if the version is earlier than 14.01, but is not displayed if 
the version is 14.01 or later. 
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Output destination folder 
selection button 

Package name 

File name 

Comment 

Package name 
(Combination File) 

 

Figure 3.1.5-1  Export File screen (Select instrument = MG3710 or MG3700) 

 

Output destination folder 
selection button 

Package name 

File name 

Comment 

 

Figure 3.1.5-2  Export File screen (Select instrument=MS269x or MS2830) 
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Comment 

Package name 
(Combination File) 

Output destination folder 
selection button 

Package name 

File name 

Antenna Port display 

 

Figure 3.1.5-3  Export File screen (when Number of Antennas = 4) 

 

Comment 

Package name 
(Combination File) 

Output destination folder 
selection button 

Package name 

File name 

Antenna Port display 

 

Figure 3.1.5-4  Export File screen (IEEE 802.11ac and Bandwidth =80+80 MHz ) 
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Comment 

Package name 
(Combination File) 

Output destination folder 
selection button 

Package name 

File name 

Antenna Port display 

 

Figure 3.1.5-5  Export File screen (IEEE 802.11ac and Number of Antennas = 8) 

 

Comment 

Package name 
(Combination File) 

Output destination folder 
selection button 

Package name 

File name 

Antenna Port display 

 

Figure 3.1.5-6  Export File screen (IEEE 802.11ac, Bandwidth =80+80MHz and 

Number of Antennas = 8) 
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Only 1-byte alphanumeric characters and the following symbols can be 
used for a file name. 

! % & ( ) + = ‘ { } _ - ^ @ [ ] 

After setting the package name, file name, and comment for the 
waveform pattern to be generated, click OK on the Export File screen. 
The Calculation screen shown in Figure 3.1.6-1 is displayed and 
waveform pattern generation starts (the package name and file name 
must be set to start waveform pattern generation).  

When started with MS269x or MS2830A and when MS269x or MS2830 is 
selected in the in the Select instrument screen, waveform pattern files 
generated by this application are saved in the following directory:   

Installed OS Export destinstion folder 

Windows Embedded 
Standard 7 

C:\Anitsu\Signal Analyzer\ 
System\Waveform 

Other than above C:\Program Files\Anritsu Corporation\ 
Signal Analyzer\System\Waveform 

 
When used with MG3710A, the files are saved in the following directory: 
C:\Anritsu\MG3710A\User Data\Waveform 

In other cases, the output destination folder can be selected from the 
Browse for Folder screen shown in Figure 3.1.5-7, which is displayed by 
clicking the output destination folder selection button on the Export File 
screen. 

 

 

Figure 3.1.5-7  Browse for Folder screen 

 

If an export destination folder is not selected, the generated waveform 
pattern will be saved in the following folder: 
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X:\IQproducer\WLAN\Data 
 (“X:\IQproducer” indicates the folder where the IQproducerTM is 
installed.) 
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3.1.6 Calculation screen 
Clicking Calculation & Load, Calculation & Play, or the OK button on 
the Export File screen will start the waveform generation.  

The Calculation screen is displayed while a waveform pattern is being 
generated. On this screen, the progress bar is displayed indicating the 
generation process of the waveform pattern and the progress of the 
waveform pattern generation. The generation of the waveform pattern 
can be stopped by clicking the Cancel button. When cancelled, it returns 
to the main screen.  

 

Progress report

Progress bar

Cancel button
 

Figure 3.1.6-1  Calculation Screen (In Progress) 

 

After waveform pattern generation is finished, the message “Calculation 
Completed.” is displayed in the progress window and the Cancel button 
changes to the OK button.  

When the generation is complete, you can return to the setting screen by 
clicking the OK button. After waveform generation, two files with .wvi 
and .wvd extension are output.   

 

 

Figure 3.1.6-2  Calculation Screen (Completed) 

Note: 

When using this software on MG3710A, and selecting Calculation 
& Load or Calculation & Play, the waveform generation ends 
without displaying the above screen.  
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When performing Calculation & Load with System=11ac and 
Bandwidth = 80+80MHz, the waveforms are loaded to the both 
SG1(Low) and SG2(Up) and four files are output.  
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3.1.7 Calculation & Load 
Note: 

This function is available only when this software is used on 
MG3710A.  

When the 2nd Vector Signal Generator (option) is installed and 
Calculation & Load is selected, the Select SG screen is displayed after 
the completion of waveform generation. 

 

Figure 3.1.7-1  Select SG Screen 

 

Select the loading destination on Select SG screen to start loading of the 
generated waveform pattern.  

However, when Bandwidth is 80+80 MHz, the loading of the waveform 
pattern starts without displaying Select SG screen. 

Note: 

To exit this screen without loading the waveform pattern, click the 
Cancel button in the Load Setting screen.  

When performing Calculation & Load on normal setup screen for 
plural waveform patterns generated with 2 or more Number of 
Antennas, load the file of the waveform pattern with the biggest 
order number. However, when the bandwidth is 80+80MHz, 
Calculation & Load is not applicable for plural waveform patterns 
generated with 2 or more Number of Antennas. 

If the version of IQproducer is earlier than 14.01, the sequence file 
(wvc file) of the waveform pattern with the biggest order number is 
loaded when plural waveform patterns are generated with 2 or 
more Number of Antennas. 
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3.1.8 Calculation & Play 
Note: 

This function is available only when this software is used on 
MG3710A.  

When Calculation & Play is selected, after waveform creation is 
completed, the created waveform is loaded into memory, selected and 
output.  

When the 2nd Vector Signal Generator (option) is installed, the Select SG 
screen is displayed before the start of waveform generation. This screen 
is used to select the signal generator for outputting the created waveform 
pattern.  

 

Figure 3.1.8-1  Select SG Screen 

 

However, when the system is 11ac and the bandwidth is 80+80 MHz, SG 
Setting screen appears instead of Select SG screen and the waveforms 
are loaded to SG1 and SG2 simultaneously. At that time, SG1 and SG2 
move to trigger stand-by state to match the timing of waveform outputs 
of SG1 and SG2. 
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On this screen, the frequency and amplitudes are settable for SG1 and 
SG2 separately. 

 

802.11ac_Low 

802.11ac_Up 

 

Figure 3.1.8-2  SG Setting screen 

 

Note: 

When performing Calculation & Play on normal setup screen for 
plural waveform patterns generated with 2 or more Number of 
Antennas, select the file of the waveform pattern with the biggest 
order number. However, when the bandwidth is 80+80MHz, 
Calculation & Play is not applicable for plural waveform patterns 
generated with 2 or more Number of Antennas. 

If the version of IQproducer is earlier than 14.01, select the 
sequence file (wvc file) of the waveform pattern with the biggest 
order number when plural waveform patterns are generated with 2 
or more Number of Antennas. 
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3.2 Waveform Pattern Generation Procedure 
3.2.1 IEEE 802.11n waveform  

This section shows a procedure for creating a waveform pattern, using an 
IEEE 802.11n waveform pattern as an example.  

<Procedure> 

1. Start the software.  

2. Set the common parameters as shown in Table 3.2.1-1. The 
parameters that are not shown below are used with their default 
values, or are automatically set according to other parameter 
settings.  

Table 3.2.1-1  Settings for common parameters 

Common 

System 11n 
Number of Packets 1 

Number of Antennas 1 
Scramble Initial Value 0x5D 

Oversampling Ratio 2 
Sampling Rate 40 MHz 

Bandwidth 20 MHz 
Duty Cycle 50.00% 

Burst On Length 544 s 
Burst Off Length 544 s 

Burst Period 1088 s 
Repeat Count 1000 

A-MPDU Off 
Filter 

Filter Type None 

Spectrum Shaping 

Windowing Length 8 

 
3. Click MPDU in the tree view and set the PHY/MAC parameters as 

shown in Table 3.2.1-2 and 3.2.1-3.  
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Table 3.2.1-2  Settings for PHY 

PHY 

PPDU Format HT Mixed 
MCS 7 

Number of Spatial Streams 1 
Modulation 64QAM 
Code Rate 5/6 

Spatial Mapping Direct Mapping 
GI Long 

Smoothing Off 
Not Sounding On 

Number of Transmit Chains 1 
Number of Space Time Streams 1 

Number of Extension Spatial 
Streams 

0 

 
Table 3.2.1-3  Settings for MAC 

MAC 

Data Length 4062 
MPDU Length 4096 

MAC Frame Type General 
Frame Control 0x0800 

Duration/ID 0x0000 
Address1 0x FFFF FFFF FFFF 
Address2 0x 2022 2222 2202 
Address3 0x 5055 5555 5505 

Sequence Control 0x0000 
Address4 0x 644D 2003 0000 
MAC FCS On 

MAC Data Type PN9fix 
Increment Sequence Number Off 
Increment Fragment Number Off 
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4. Click Calculation to open the Export File screen, and specify the 
output destination with Export Path. Next, select WLAN for 
Package and specify MCS7_MIX_20M for Export File Name, and 
then click OK.  

5. The Calculation screen is displayed and waveform pattern 
generation starts. After the calculation is completed, click OK to 
finish the waveform generation.  

6. The MCS7_MIX_20M.wvi, MCS7_MIX_20M.wvd and 
MCS7_MIX_20M.xml files are output to the folder selected on the 
Export File screen (described in Section 3.1.5).  

If IQproducer is started in the MG3700A mode, the 
MCS7_MIX_20M_.wvi, MCS7_MIX_20M_.wvd, and 
MCS7_MIX_20M.wvc files are also output in addition to these files.  

The wvc file is a scenario file used to specify how many times to 
repeatedly output the waveform patterns, as well as to specify the 
combination of waveform patterns. If a wvc file that is output from 
the MG3700A is selected, the waveform patterns are output the 
number of times set by Repeat Count (Common parameter).  

For details of operation, refer to each one of the following: 

 MG3700A Vector Signal Generator Operation Manual (Mainframe) 
3.5.2 (3) “To execute continuous operations in Defined mode”  

 MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (Mainframe) 
7.3.2 “Pattern generation mode” 
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3.2.2 IEEE 802.11ac waveform 
This section describes the waveform pattern generation procedure, using 
the IEEE 802.11ac waveform pattern as an example. 

<Procedure> 

1. Start the software.  

2. Set the common parameters as Table 3.2.2-1. The parameters that 
are not listed below are used with their default values, or are 
automatically set according to other parameter settings.  
For Burst On Length, Burst Off Length, and Burst Period, their 
values calculated after setting the PHY and MAC parameters are 
set.  

Table 3.2.2-1  Settings for common parameters 

Common 

System 11ac 
Number of Packets 1 

Number of Antennas 1 
Total Output Packets 1000 
Oversampling Ratio 2 

Sampling Rate 160 MHz 
Bandwidth 80 MHz 
Duty Cycle 50.00% 

Burst On Length 128 s 
Burst Off Length 128 s 

Burst Period 256 s 
Repeat Count 1000 

Scramble Initial Value 0x5D 

Filter 

Filter Type None 

Spectrum Shaping 

Windowing Length 8 
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Table 3.2.2-2  Settings for IEEE802.11ac 

IEEE802.11ac 

PPDU Format VHT 
User Mode Single User 

Number of Transmit Chains 1 
Spatial Mapping Direct Mapping 

GI Long 
Total Number of Space Time 

Streams 
1 

 
3. Click User0/MPDU in the tree view and set the PHY/MAC 

parameters as Table 3.2.2-3 and 3.2.2-4.  

 

Table 3.2.2-3  Settings for PHY 

PHY 

Scramble On 
MCS 9 

Number of Spatial Streams 1 
Modulation 256QAM 
Code Rate 5/6 

Coding Mode BCC 
Coding On 

BCC Interleaver On 
Number of Space Time Streams 1 

Group ID 0x3F 
Partial AID 000 

TXOP PS NOT ALLOWED 1 

 



 

3.2 Waveform Pattern Generation Procedure 

3-71 

3 

N
orm

al S
etu

p S
creen

 

Table 3.2.2-4  Settings for MAC 

MAC 

A-MPDU Off 
Data Length 4062 

MPDU Length 4096 
MAC Frame Type General 

Frame Control 0x0800 
Duration/ID 0x0000 

Address1 0x FFFF FFFF FFFF 
Address2 0x 2022 2222 2202 
Address3 0x 5055 5555 5505 

Sequence Control 0x0000 
Address4 0x 644D 2003 0000 
MAC FCS On 

MAC Data Type PN9fix 
Increment Sequence Number Off 
Increment Fragment Number Off 

 
4. Click the Calculation button to display the Export File screen. 

Specify the output destination with Export Path. Next, select WLAN 
for Package and specify MCS9_80M for Export File Name, and then 
click OK.  

5. The Calculation screen is displayed and waveform pattern 
generation starts. After the calculation is completed, click OK to 
finish the waveform generation. 

6. The MCS9_80M.wvi, MCS9_80M.wvd and MCS9_80M.xml files are 
output to the folder selected on 3.1.5 “Export File screen”.  

If IQproducer is started in the MG3700A mode, the MCS9_80M_.wvi, 
MCS9_80M_.wvd, MCS9_80M.wvc files are also output in addition 
to these files. 

The wvc file is a scenario file used to specify how many times to 
repeatedly output the waveform patterns, as well as to specify the 
combination of waveform patterns. If a wvc file that is output from 
the MG3700A is selected, the waveform patterns are output the 
number of times set by Repeat Count (Common parameter).  

For details of operation, refer to each one of the following: 

 MG3700A Vector Signal Generator Operation Manual (Mainframe) 
3.5.2 (3) “To execute continuous operations in Defined mode” 

 MG3710A Vector Signal Generator MG3740 Analog Signal Generator 
Operation Manual (Mainframe) 
7.3.2 “Pattern generation mode” 
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3.3 Saving/Reading Parameters 
The numeric values and settings for each item can be saved in a 
parameter file by using the software.  

3.3.1 Saving a parameter file 
When running on PC, MS2690A/MS2691A/MS2692A, or MS2830A 

1. Select Save Parameter File from the File menu or click the   
tool button to display the parameter file saving screen.  

 

 

Figure 3.3.1-1  Parameter file saving screen 

 

2. Specify Save in, enter a file name in the File name text box, and 
click Save to save the parameter file.  

 

When running on MG3710A  

1. Click the Save Parameter File button in File menu or click the   
button to display the parameter file saving screen.  

 

Figure 3.3.1-2  Parameter file saving screen (MG3710A) 
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2. Select the folder to store the file in the Directories field, and then 
enter the name of the file using the File Name box. Click OK to save 
the parameter file. To initialize the setting in the Directories field, 
click the Default Root button. 

 

3.3.2 Reading a parameter file 
When running on PC, MS2690A/MS2691A/MS2692A, or MS2830A 

1. Select Save Parameter File from the File menu or click the   
tool button to display the parameter file saving screen. 

 

 

Figure 3.3.2-1  Parameter file reading screen 

 

2. Select a parameter file to be read from the file list, and then click 
Open to read the selected parameter file.  

X:\IQproducer\WLAN\sampleuserfile  

The sample parameter files for creating a wave pattern are stored in this 
folder (X:\IQproducer is the IQproducerTM installation folder).  

When running on MG3710A 

1. Select Recall Parameter File from the File menu or click the  
tool button to display the parameter file reading screen.  
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Figure 3.3.2-2  Parameter file reading screen (MG3710A) 

 

(2) Select the directory where the files to be loaded is stored in the 
Directories field. Click the desired file from the File List, and click 
OK. To initialize the setting in the Directories field, click the Default 
Root button. 
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3.4 User File Reading Screen 
When running on PC, MS2690A/MS2691A/MS2692A, or MS2830A 

1. When User File is selected in each layer, the User File reading 
screen.  

 

 

Figure 3.4-1   User file reading screen 

 

2. Select a user file to be read from the file list, and then click Open to 
read the selected user file.  

If an unsupported User File is selected, an error is displayed. Refer to 
Appendix B “User File Format” for details on the user file format. 

When running on MG3710A 

1. When User File is selected for MAC Data Type setting in the 
Channel Setting screen, the user file reading screen is displayed. 

 

Figure 3.4-2  User file reading screen (MG3710A) 
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2. Select the directory where the user files to be loaded is stored in the 
Directories field. Click the desired file from the File List, and click 
OK. To initialize the setting in the Directories field, click the Default 
Root button.  

If an unsupported User File is selected, an error is displayed. Refer to 
Appendix B “User File Format” for details on the user file format. 
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3.5 Graph Display  
The generated waveform pattern can be displayed in a CCDF, FFT, and 
Time Domain graph by using this software. For details of each graph 
display, refer to each one of the following: 

When making a graph from the waveform patterns generated with the 
system 11ac and the bandwidth 80+80 MHz, a lower waveform is selected 
automatically. 

 MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™) 
4.3 “CCDF Graph Display”, 4.4 “FFT Graph Display”, 4.13 “Time 
Domain Graph Display” 

 MS2690A/MS2691A/MS2692A or MS2830A Vector Signal Generator 
Operation Manual (IQproducer™) 
4.3 “CCDF Graph Display”, 4.4 “FFT Graph Display”, 4.9 “Time 
Domain Graph Display” 

 

Displaying CCDF graph 

1. Generate a waveform pattern menu by executing “Calculation”. 

2. Select CCDF from the Simulation menu or click the  tool 
button. The CCDF Graph Monitor screen shown in Figure 3.5-1 is 
displayed with the trace of the generated waveform pattern. 

 

Figure 3.5-1  CCDF Graph Monitor screen 
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 When a waveform pattern is generated by changing parameters and 
executing “Calculation” while other traces are displayed in the 
CCDF Graph Monitor screen, the trace of the waveform pattern 
newly generated can be displayed in either of the following two 
methods: 

 Displaying the new trace in the same screen as the previous 
traces 

 Deleting the previous traces to display the new trace 
 

 Note: 

The CCDF, FFT, and Time Domain graphs cannot be 
generated at the same time. When displaying one graph while 
another graph is being displayed, execute the graph generation 
of the former after that of the latter is completed. 

 

 

■ Displaying the new trace in the same screen as the previous traces 

1. Set Add for Quick Add Mode on the lower-left of the CCDF Graph 
Monitor screen. 

2. When CCDF is clicked in the Simulation menu or  is clicked, 
a trace of the newly generated waveform pattern is added to the 
CCDF Graph Monitor screen.  
Up to eight traces can be displayed by repeating this procedure.  

 
■ When deleting the previous traces to display a new trace: 

1. Set Clear for Quick Add Mode on the lower-left of the CCDF 
Graph Monitor screen.  

2. Select CCDF from the Simulation menu or click the  tool 
button. The confirmation message shown in Figure 3.5-2 below 
appears:  

 

Figure 3.5-2  Confirmation message 

 

 Click Yes. The previous traces are deleted, and the trace of the 
waveform pattern newly generated is displayed.  
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Displaying FFT graph 

1. Generate a waveform pattern by executing “Calculation”. 

2. Select FFT from the Simulation menu or click the  tool 
button. The FFT Graph Monitor screen shown in Figure 3.5-3 is 
displayed with the trace of the generated waveform pattern.  

 

 

Figure 3.5-3  FFT Graph Monitor screen 

 

 When a waveform pattern is generated by changing parameters and 
executing “Calculation” while other traces are displayed in the FFT 
Graph Monitor screen, the trace of the waveform pattern newly 
generated can be displayed in either of the following two methods:  

 Displaying the new trace in the same screen as the previous 
traces 

 Deleting the previous traces to display the new trace 
 

 Note: 

The CCDF, FFT, and Time Domain graphs cannot be 
generated at the same time. When displaying one graph while 
another graph is being displayed, execute the graph generation 
of the former after that of the latter is completed. 

 

 



 

Chapter 3  Normal Setup Screen 

3-80 

■ Displaying the new trace in the same screen as the previous traces 

1. Set Add for Quick Add Mode on the lower-left of the FFT Graph 
Monitor screen. 

2. When FFT is clicked in the Simulation menu or  is clicked, 
a trace of the newly generated waveform pattern is added to the 
FFT Graph Monitor screen.  
Up to four traces can be displayed by repeating this procedure. 

■ When deleting the previous traces to display a new trace: 

1. Set Clear for Quick Add Mode on the lower-left of the FFT Graph 
Monitor screen.  

2. Select FFT from the Simulation menu or click the  tool 
button. The confirmation message shown in Figure 3.5-4 below 
appears: 

 

Figure 3.5-4  Confirmation message 

 

 Click Yes. The previous traces are deleted, and the trace of the 
waveform pattern newly generated is displayed.  
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Displaying the Time Domain graph 

1. Generate a waveform pattern by executing “Calculation”. 

2. When Time Domain is clicked in the Simulation menu or  is 
clicked, the Time Domain graph screen shown in Figure 3.5-5 is 
displayed, along with a trace of the generated waveform pattern.  

 

 

Figure 3.5-5  Time Domain screen 

 

 When a waveform pattern is generated by changing parameters and 
executing “Calculation” while other traces are displayed in the Time 
Domain Graph Monitor screen, the trace of the waveform pattern 
newly generated can be displayed in either of the following two 
methods:  

 Displaying the new trace in the same screen as the previous 
traces 

 Deleting the previous traces to display the new trace 
 

 Note: 

The CCDF, FFT, and Time Domain graphs cannot be 
generated at the same time. When displaying one graph while 
another graph is being displayed, execute the graph generation 
of the former after that of the latter is completed. 
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■ Displaying the new trace in the same screen as the previous traces 

1. Set Add for Quick Add Mode on the lower-left of the Time 
Domain Graph Monitor screen.  

2. When Time Domain is clicked in the Simulation menu or  
is clicked, a trace of the newly generated waveform pattern is 
added to the Time Domain graph screen. 
Up to four traces can be displayed by repeating this procedure.  

 

■ When deleting the previous traces to display a new trace: 

1. Set Clear for Quick Add Mode on the lower-left of the Time 
Domain Graph Monitor screen.  

2. When Time Domain is clicked in the Simulation menu or  
is clicked, a message such as that shown in Figure 3.5-6 is 
displayed.  

 

Figure 3.5-6  Confirmation message 

 

 Click Yes. The previous traces are deleted, and the trace of the 
waveform pattern newly generated is displayed.  
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3.6 Auxiliary Signal Output 
Select a waveform pattern generated by the WLAN IQproducer™ on this 
equipment to output the marker that is synchronized with the RF signal 
as an auxiliary signal from the AUX on the rear panel of this equipment.  
When creating waveform patterns, markers can be set automatically in 
the waveform pattern as shown below.  
A waveform pattern with edited markers can be created using the 
Marker Edit function for Time Domain graphs. 
 
For details of Marker Edit function, refer to each one of the following:  

 MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™) 
4.13.12 “Marker edit function” 

 MS2690A/MS2691A/MS2692A or MS2830A Vector Signal Generator 
Operation Manual (IQproducer™) 
4.9.12 “Marker edit function” 

 
For details of the error range of the auxiliary signals against the RF 
output, refer to each one of the following:  

 MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™) 
4.5.6 “Input file format” 

 MS2690A/MS2691A/MS2692A or MS2830A Vector Signal Generator 
Operation Manual (IQproducer™) 
4.5.6 “Input file format” 
 

 



 

Chapter 3  Normal Setup Screen  

 

3-84. 

 



 
Chapter 4  Easy Setup Screen 

4-1 

4 

E
asy S

etu
p S

creen
 

This chapter explains the Easy Setup screens that are displayed when 
this software is installed and running on the MG3710A. The Easy Setup 
screens support touch-panel operations.  

Note: 

In the operation explanations in this chapter, touching the touch 
panel and clicking the mouse are both described as “click”.  

 

4.1 Basic Operation ............................................................ 4-2 

4.1.1 Data input method ............................................ 4-2 

4.2 Screen Details ............................................................... 4-5 

4.2.1 Menu and tool buttons ...................................... 4-5 

4.2.2 Tool bar ............................................................ 4-7 

4.2.3 Save/Recall ...................................................... 4-8 

4.2.4 Export File screen ............................................. 4-9 

4.2.5 Calculation screen .......................................... 4-10 

4.2.6 Calculation & Load ......................................... 4-10 

4.2.7 Calculation & Play .......................................... 4-10 

4.2.8 Select Option .................................................. 4-11 

4.2.9 Common Tab .................................................. 4-12 

4.2.10 PHY Tab ......................................................... 4-17 

4.2.11 MAC Tab ........................................................ 4-30 

4.3 Graph Display ............................................................. 4-37 

4.4 Auxiliary Signal Output ............................................... 4-38 
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4.1 Basic Operation 
4.1.1 Data input method 

The measurement item selections, numeric data, alphabetic characters, 
etc., are input at the panel displayed on the screen.  
The displayed panel differs according to the input data type.  
 

■ Numeric keypad 

Clicking the numeric input text box displays numeric input panel. The 
displayed keys, units and input range differ according to the data.  
 

Data name

Clear

Back
space

Enter

Data range

Exit 

 

Figure 4.1.1-1  Numeric Keypad 
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■ Hexadecimal keypad   

Clicking the Mac Frame Format field displays the hexadecimal keypad. 
 

 
Data name

Clear 

Back space

Enter 

Data range

Exit 

 

Figure 4.1.1-2  Hexadecimal Keypad 

 

■ Software keyboard 

Character data such as file names are input by clicking the character 
input text box. Characters are input by clicking the keys of the soft 
keyboard shown in Figure 4.1.1-2. Click the Shift + Caps keys to lock the 
keyboard; click them again to unlock the keyboard.  

 

BackspaceCancel OK Mov e cursor 
 

Figure 4.1.1-3  Software Keyboard 
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Figure 4.1.1-4  Software Keyboard (With Shift Key Locked) 

 

 

Figure 4.1.1-5  Software Keyboard (With Caps Key Locked) 

 



 

4.2 Screen Details  

4-5 

4 

E
asy S

etu
p S

creen
 

4.2 Screen Details 
4.2.1 Menu and tool buttons 

On common platform screen, select the System (Cellular) tab, and then 
select WLAN to display the main screen. 

 
Tool Bar Parameter Setting Frame 

 

Figure 4.2.1-1  Main Screen (Easy Setup (Common)) 

 

Note: 

When this software is running on PC, the Calculation & Load 
button in the Pattern Setting field changes to Calculation, and the 
Calculation & Play button changes to Exit, respectively. 

When launching IQproducer on the MG3710, the Package 
(Combination File) box is not displayed if the version is 14.01 or later.  
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■Screen transition 

The screen hierarchy from the Main screen to (Easy Setup) the 
sub-screens (Normal Setup and Calculation) after WLAN IQproducer 
starts is shown below.  

   

波形生成画面 

・Calculation button 

・Calculation & Load button

・Calculation & Play button 

Reflection of parameters

・Normal Setup button

Initialization of parameters

・Easy Setup button 

・Calculation button 

・Calculation & Load (Menu)

・Calculation & Play (Menu)

Normal Setup screen 

Calculation screen 

Main screen (Easy Setup screen)

 

Figure 4.2.1-2  Screen Transition 
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4.2.2 Tool bar 
The tool bar ribbon at the top of the Main screen has various operation 
buttons.  

Save Recall CCDF FFT Time Domain Clipping Exit Normal  Setup Calculation 
Calculation  

& Load 

Calculation 

& Play 

Transfer & 

Setting Wizard  

Figure 4.2.2-1  Tool Bar 

 
■ Buttons on Tool Bar 

 

Button Name Description 

 Recall Parameter File Displays Recall dialog for loading parameter file 
(Figure 4.2.3-2)  

 Save Parameter File Displays Save dialog for saving parameter file (Figure 
4.2.3-1)  

 Calculation  Performs waveform pattern generation.  

 Calculation & Load 
After waveform generation is finished, the created 
waveform pattern is loaded into the MG3710A 
waveform memory.  

 Calculation & Play 
After waveform generation is finished, the created 
waveform pattern is loaded and selected at the 
MG3710A waveform memory.  

 Transfer & Setting 
Wizard 

Every operation ranging from connecting the PC and 
MG3700A/MG3710A and transferring the waveform 
pattern to the MG3700A/MG3710A, to loading the 
waveform pattern into the MG3700A/MG3710A ARB 
memory is performed at this screen. 

 CCDF Fetches CCDF graph screen and displays CCDF of 
created waveform pattern.  

 FFT Fetches FFT graph screen and displays spectrum of 
FFT transformed waveform data.  

 Time Domain 
Displays the Time Domain screen. In this screen, the 
time domain waveform of a generated waveform 
pattern is displayed in a graph.  

 Clipping 
Displays the Clipping setting screen. In this screen, 
clipping and filtering processing can be performed for 
a generated waveform pattern.  

 Exit 
Quits software.  

 Normal Setup 
Switches GUI to Normal Setup mode; for details of 
Normal Setup, refer to Chapter 3 “Normal Setup 
Screen”.  
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Note: 

 Transfer&Setting Wizard is available only when MG3700 or 
MG3710 is selected in the Select instrument screen. 

 Calculation & Load button and Calculation & Play button become 
active only when operated on MG3710A.  

4.2.3 Save/Recall 
Clicking Save opens the Save dialog box (Figure 4.2.3-1), where you can 
enter a parameter name. Note that the screen keyboard is used to enter a 
character string on the MG3710A mainframe. 

 

 

Figure 4.2.3-1  Save Dialog Box 
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Clicking Recall opens the Recall dialog box (Figure 4.2.3-2), where you 
can select a parameter file, on the MG3710A mainframe.  

Loading the parameter file stored in the Sample userfile folder can set 
the same parameters as the reference waveform patterns. 

 

Figure 4.2.3-2  Recall Dialog Box 

 

Note: 

The Normal Setup and Easy Setup parameter files are different. 
When the Normal Setup parameter file is loaded on the Easy 
Setup screen, the screen switches to the Normal Setup screen. 

4.2.4 Export File screen 
When Calculation is selected from the Edit menu or the   tool 
button is clicked on the main screen, the Export File screen is displayed. 

For details on the Export File screen, refer to 3.1.5 “Export File screen”. 
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4.2.5 Calculation screen 
Clicking Calculation & Load and Calculation & Play in the Easy Setup 
screen or OK in the Export File dialog box starts waveform generation. 

For details on the Calculation screen, refer to 3.1.6 “Calculation screen”. 

 

4.2.6 Calculation & Load 
Note: 

This function is available only when this software is used on 
MG3710A. 

Clicking Calculation & Load starts waveform generation. The Load 
Setting screen is displayed after completion of waveform generation.  

For details, refer to 3.1.7 “Calculation & Load”.  

 

4.2.7 Calculation & Play 
Note: 

This function is available only when this software is used on 
MG3710A. 

Clicking Calculation & Play selects and outputs the generated waveform 
pattern after completion of waveform generation.  

For details, refer to 3.1.8 “Calculation & Play”. 
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4.2.8 Select Option 
Note: 

This function is not available when this software is used on 
MG3710A or MS269x is selected in the Select instrument screen.  

To change the Select Option, click Select Option to display the Select 
Option screen, where you can set the select option information. The 
Select Option screen depends on the mode as shown in Figures 4.2.8-1, 
4.2.8-2, and 4.2.8-3. 

 

Figure 4.2.8-1  Select Option Screen (MG3710) 

 

 

Figure 4.2.8-2  Select Option Screen (MG3700) 

 

 

Figure 4.2.8-3  Select Option Screen (MS2830) 
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4.2.9 Common Tab 
This subsection describes the parameters in the Common tab. 

 Tool Bar Parameter Setting Frame 

 

Figure 4.2.9-1  Common Tab 

 

System 

[Function] Sets the system. 
[Default] 11g 
[Setting range] 11a, 11ac, 11b, 11g, 11j, 11n, 11p 

 

 

Figure 4.2.9-2  System Setting Screen 
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Number of Packets 

[Function] Sets the number of packets to be generated. 
[Default] 1 
[Setting range] 1 to the maximum number of packets for the waveform 

memory 
[Remarks] Set the value using the numeric keypad. 
 
Repeat Count  

[Function] Sets the repeat count of packet to be transmitted. 
[Default] 1000 
[Setting range] 1 to 32767 
[Remarks] The setting is void if MS269x or MS2830 is selected in the 

Select instrument dialog box.  
 Set the value using the numeric keypad. 

 

Total Output Packets  

[Function] Displays the total number of packets 
 (Number of Packets × Repeat Count). 

[Remarks] The display is void if MS269x or MS2830 is selected in 
the Select instrument dialog box. 

 

Bandwidth 

[Function] Sets the bandwidth. 
[Default] The default for each system is as follows: 
 

System Default 

System=11a 20 MHz 
System=11j 20 MHz 
System=11n 20 MHz 
System=11p 10 MHz 
System=11ac 20 MHz 

 
[Setting range] The setting range for each system is as follows: 
 

System Setting range 

System=11a 20 MHz 
System=11j 20 MHz 
System=11n 20 MHz or 40 MHz 
System=11p 10 MHz 
System=11ac 20 MHz, 40 MHz, 80 MHz, 160 MHz, 80+80 MHz  

*160 MHz is not settable if 
MG3700A/MS2830A/MS269xA is selected in the 
Select instrument dialog box. 
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[Remarks] This function is disabled when System is set to 11b or 11g. 
 

 

 

Figure 4.2.9-3  Bandwidth Setting Screen 

 
Duty Cycle 

[Function] Sets the On/Off ratio of the burst signal. 
[Default] 50.0000 [%] 
[Setting range] 0.1000 to 99.0000 [%] 
[Resolution] 0.0001 
[Remarks] When setting Duty Cycle, Burst Off Length and Burst 

Period are automatically calculated. Also, when Burst On 
Length or Burst Off Length is changed, Duty Cycle is 
automatically calculated. 

 The setting range is automatically calculated according to 
the Common, PHY, MAC parameter settings, so it is not 
always from 0.1000 to 99.0000 [%]. 

 
Burst On Length 

[Function] Displays the burst on length [s]. 
[Setting range] Displays the calculated value.  
[Resolution] 0.001 
[Remarks] The calculated result is rounded to a multiple of 

1/Sampling Rate [s]. Automatically calculated by 
PHY/MAC parameter setting.  

 

Burst Off Length 

[Function] Sets the burst off length [s]. 
[Setting range] The setting range is decided by the maximum and 

minimum values of Duty Cycle and the calculated value 
of Burst On Length. 

[Resolution] 0.001 
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[Remarks] When setting Burst Off Length, Duty Cycle and Burst 
Period are automatically calculated.  
Also, Burst Off Length is calculated from the values of 
Duty Cycle and Burst On Length as below.  
Burst Off Length= Burst On Length ×  

(100.0 – Duty Cycle) / Duty Cycle 
 
Burst Period 

[Function] Display the burst period [s]. 
[Display range] Displays the calculated value.  
[Remarks] The following figure shows the relationships among Duty 

Cycle, Burst On Length, Burst On Length, and Burst 
Period. 

 

 
T1 : Burst On Length 
T2 : Burst Off Length 
T3 : Burst Period 
T1/T3 : Duty Cycle 

 
Filter Type 

[Function] Sets the filter type. 
[Default] The default for each system is as follows: 
 When System is set to 11b or when System is set to 11g 

and Frame Format is other than ERP-OFDM or 
DSSS-OFDM: Gaussian 

Others: None 
[Setting range] None, Gaussian, Root Nyquist, Nyquist, Ideal 
 

 

Figure 4.2.9-4  Filter Type Setting Screen 
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Roll Off/BT 

[Function] Sets the roll-off factor or BT product. 
[Default] 0.50 
[Setting range] 0.10 to 1.00 
[Resolution] 0.01 
[Remarks]  The setting is fixed when Filter Type is set to Ideal or 

None. 
 
Windowing Length 

[Function] Sets the windowing length. 
[Default] 8 Samples 
[Setting range] 0 to 32 × Oversampling Rate 
[Remarks] This function cannot be set in the following cases: 

Where System is set to 11b. 
 Where System is set to 11g and Frame Format is set to 

other than ERP-OFDM or DSSS-OFDM. 
 The setting range is 0 to 32 when System is set to 11ac 

and Bandwidth is set to 160 MHz. 

 
Ramp Length 

[Function] Sets the ramp length. 
[Default] 8 Samples 
[Setting range] 0 to 16 × Oversampling Rate 
[Remarks] This function can be set in the following cases: 
 Where System is set to 11b. 

 Where System is set to 11g and Frame Format is set to 
other than ERP-OFDM or DSSS-OFDM. 
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4.2.10 PHY Tab 
This subsection describes the parameters in the PHY tab. 

 
Tool barParameter Setting Frame

 

Figure 4.2.10-1  PHY Tab (When System is Set to Other Than 11n or 11ac) 
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Tool bar Parameter Setting Frame 

 

Figure 4.2.10-2  PHY Tab (When System is Set to 11n and 

PPDU Format is Set to HT Mixed or HT-GreenField) 
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 Tool bar Parameter Setting Frame 

 

Figure 4.2.10-3  PHY Tab (When System is Set to 11n and PPDU Format is Set to 

Non-HT) 
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Tool bar Parameter Setting Frame 

 

Figure 4.2.10-4  PHY Tab (When System is Set to 11ac) 

 

PPDU Format 
[Function] Sets the PPDU Format. 
[Default] The default for each system is as follows: 
 When System is set to 11n: HT Mixed 
 When System is set to 11ac: VHT 
[Setting range] The setting range for each system is as follows: 
 When System is set to 11n: Non-HT, HT-Mixed, and 

HT-Greenfield  
 When System is set to 11ac: VHT 
[Remarks] This function can be set in the following cases: 

Where System is set to 11n or 11ac. 

 

Figure 4.2.10-5  PPDU Format Setting Screen 
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MCS 

[Function] Sets the MCS. 
[Default] The default for each system is as follows: 
 When System is set to 11n: 7 
 When System is set to 11ac: 8 
[Setting range] The setting range for each system is as follows: 
 When System is set to 11n: 0 to 7 
 When System is set to 11ac: 0 to 9 
[Remarks]  This function can be set in the following cases: 
 Where System is set to 11n and PPDU Format is set to 

HT Mixed or HT-GreenField or where System is set to 
11ac. 
 Parameters for MCS setting is defined in IEEE Std 
802.11n-2009 - Chapter 20.6 and IEEE P802.11ac/D2.0, 
January 2012 - Chapter 22.5. 

 

Number of Spatial Streams 

[Function]  Sets the number of streams. 
[Default] 1 
[Setting range] 1 
[Remarks] This function can be used when System is set to 11n and 

PPDU Format is set to HT Mixed or HT-Greenfield or 
when System is set to 11ac. 

 

Data Rate 
[Function] Sets the data rate. 
[Default] The default for each system is as follows: 
 When System is set to 11a, 11g, or 11j: 54 Mbps 
  When System is set to 11b: 11 Mbps 
  When System is set to 11p: 27 Mbps 
[Setting range] 1, 2, 3, 4.5, 5.5, 6, 9, 11, 12, 18, 22, 24, 27, 33, 36, 48, 54 
[Remarks]  This function cannot be set in the following cases: 

 Where System is set to 11n and PPDU Format is HT 
Mixed or HT-Greenfield or where System is set to 11ac. 
When System=11n and PPDU format=Non-HT,  
the setting range is the same as System=11a.  
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Table 4.2.10-1  Alternatives When System is set to 11a or 11j, 

11n(PPDU format=Non-HT) 

Data Rate Frame 
Format 

Modulation High Rate 
Modulation 

Code 
Rate 

6 Mbps N/A BPSK N/A 1/2 
9 Mbps BPSK 3/4 
12 Mbps QPSK 1/2 
18 Mbps QPSK 3/4 
24 Mbps 16QAM 1/2 
36 Mbps 16QAM 3/4 
48 Mbps 64QAM 2/3 
54 Mbps 64QAM 3/4 

 

 

Figure 4.2.10-6  Data Rate Setting Screen (When System is Set to 11a, 11j) 

 

 

Figure 4.2.10-7  Data Rate Setting Screen  

(When System is Set to 11n(PPDU format=Non-HT)) 
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Table 4.2.10-2  Alternatives When System is Set to 11b 

Data Rate Frame 
Format 

Modulation High Rate 
Modulation 

Code 
Rate 

1 Mbps N/A DBPSK N/A N/A 
2 Mbps DQPSK N/A 
5.5 Mbps N/A CCK, 

PBCC 

11 Mbps N/A CCK, 
PBCC 

 

 

Figure 4.2.10-8  Data Rate Setting Screen (When System is Set to 11b) 
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Table 4.2.10-3  Alternatives When System is Set to 11g 

Data 
Rate 

Frame 
Format 

Modulation High Rate 
Modulation 

Code 
Rate 

1 Mbps ERP-DSSS DBPSK N/A N/A 
2 Mbps ERP-DSSS DQPSK N/A N/A 
5.5 Mbps ERP-CCK 

ERP-PBCC 
N/A CCK, 

PBCC 
N/A 

6 Mbps ERP-OFDM, 
DSSS-OFDM 

BPSK N/A 1/2 

9 Mbps ERP-OFDM, 
DSSS-OFDM 

BPSK N/A 3/4 

11 Mbps ERP-CCK 
ERP-PBCC 

N/A CCK, 
PBCC 

N/A 

12 Mbps ERP-OFDM, 
DSSS-OFDM 

QPSK N/A 1/2 

18 Mbps ERP-OFDM, 
DSSS-OFDM 

QPSK N/A 3/4 

22 Mbps ERP-PBCC N/A PBCC N/A 
24 Mbps ERP-OFDM, 

DSSS-OFDM 
16QAM N/A 1/2 

33 Mbps ERP-PBCC N/A PBCC N/A 
36 Mbps ERP-OFDM, 

DSSS-OFDM 
16QAM N/A 3/4 

48 Mbps ERP-OFDM, 
DSSS-OFDM 

64QAM N/A 2/3 

54 Mbps ERP-OFDM, 
DSSS-OFDM 

64QAM N/A 3/4 

 

 

Figure 4.2.10-9  Data Rate Setting Screen (When System is Set to 11g) 
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Table 4.2.10-4  Alternatives When System is Set to 11p 

Data Rate Frame 
Format 

Modulation High Rate 
Modulation 

Code 
Rate 

3 Mbps N/A BPSK N/A 1/2 
4.5 Mbps BPSK 3/4 
6 Mbps QPSK 1/2 
9 Mbps QPSK 3/4 
12 Mbps 16QAM 1/2 
18 Mbps 16QAM 3/4 
24 Mbps 64QAM 2/3 
27 Mbps 64QAM 3/4 

 

 

Figure 4.2.10-10  Data Rate Setting Screen (When System is Set to 11p) 
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Modulation 

[Function] Displays the PSDU modulation method. 
[Default] The default for each system is as follows: 

 When System is set to 11a, 11g, 11j, 11p or 11n (PPDU 
Format is Non-HT): 64QAM 
When System is set to 11ac: 256QAM 

[Display range] BPSK, QPSK, 16QAM, 64QAM, 256QAM,  
 DBPSK, DQPSK 
[Remarks] This function is disabled when System is set to 11b and 

Data Rate is set to 5.5, 11 Mbps or when System is set to 
11g and Data Rate is set to 5.5, 11, 22, 33 Mbps. 

 This function is disabled when System is set to 11n and 
PPDU Format is set to HT Mixed or HT-Greenfield. 

 

High Rate Modulation 

[Function] Sets the modulation method for direct sequence spread 
spectrum. 

[Default] CCK 
[Setting range] CCK, PBCC 
[Remarks] This function can be set in the following cases: 

 Where System is set to 11b. 
Where System is set to 11g and Frame Format is set to 
ERP-CCK or ERP-PBCC.  
 Both CCK and PBCC can be selected where Data Rate is 
set to 5.5 Mbps or 11 Mbps. 
Note that Frame Format is automatically set to: 
ERP-CCK when High Rate Modulation is CCK. 
ERP-PBCC when High Rate Modulation is PBCC.  
Only PBCC can be selected where Data Rate is set to 
22Mbps or 33 Mbps. 
Only PBCC can be selected where Data Rate is set to 
22Mbps or 33 Mbps. 

 

Figure 4.2.10-11  High Rate Modulation Setting Screen 
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Code Rate 

[Function] Displays the coding rate. 
[Default] 3/4 
[Display range] 1/2, 2/3, 3/4, 5/6 
[Remarks] This function is disabled when System is set to 11b or 11g 

and Data Rate is set to 1, 2, 5.5, 11, 22, 33 Mbps. 
  
Preamble Type 

[Function] Sets the preamble type. 
[Default] Long 
[Setting range] Long, Short 
[Remarks] This function can be set in the following cases: 

 •Where System is set to 11b. 
 •Where System is set to 11g. 
 Only Long is available where all the following conditions 
are satisfied: 
•Where System is set to 11g. 
•Where Frame Format is set to ERP-DSSS. 
•Where Data Rate is set to 1 Mbps.  
Only Long is available where both of the following 
conditions are satisfied: 
•Where System is set to 11g. 
•Where Frame Format is set to ERP-OFDM. 
Also, only Long is available where System is set to 11b 
and Data Rate is set to 1 Mbps. 

 

Figure 4.2.10-12  Preamble Type Setting Screen 
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Frame Format 

[Function] Sets the secondary modulation method for header and 
payload. 

[Default] ERP-OFDM 
[Setting range] ERP-OFDM, DSSS-OFDM, ERP-DSSS, ERP-CCK, 

ERP-PBCC 
[Remarks] This function can be set in the following cases: 

 Where System is set to 11g. 
Also, Frame Format is automatically set to: 
•ERP-CCK when High Rate Modulation is CCK. 
•ERP-PBCC when High Rate Modulation is PBCC. 

 

 

 

 

Figure 4.2.10-13  Frame Format Setting Screen 
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GI 

[Function] Sets the guard interval length. 
[Default] Long 
[Setting range] Short, Long 
[Remarks] This function can be set in the following cases: 

 Where System is set to 11n and PPDU Format is HT 
Mixed or HT-Greenfield or where System is set to 11ac. 

 

Figure 4.2.10-14  Frame Format Setting Screen 

 
Coding Mode 

[Function] Sets the coding mode. 
[Default] BCC 
[Remarks] This function can be set in the following cases: 

Where System is set to 11ac. 
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4.2.11 MAC Tab 
This subsection describes the parameters in the MAC tab. 

 Tool bar Parameter Setting Frame 

 

Figure 4.2.11-1  MAC Tab (When System is Set to Other Than 11n or 11ac) 
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 Tool bar Parameter Setting Frame 

 

Figure 4.2.11-2  MAC Tab (When System is Set to 11n or 11ac) 

 

Data Length 

[Function]  Sets the data length. 
[Default] The default for each system is as follows: 
 When System is set to 11a, 11g (with Frame Format set to 

DSSS-OFDM or ERP-OFDM), 11j or 11p: 966 [octet(s)]  
  When System is set to 11b or 11g (with Frame Format set 

to ERP-DSSS, ERP-PBCC or ERP-CCK): 990 [octet(s)] 
When System is set to 11n and Frame Format is set to 
Non-HT: 4061 [octet(s)]  

 When System is set to 11n and PPDU Format is set to HT 
Mixed or HT Greenfield: 4062 [octet(s)]  
When System is set to 11ac: 4062 [octet(s)]  

[Setting range] The setting range for each system is as follows: 
 When System is set to 11a, 11b, 11g, 11j or 11p or when 

System is set to 11n and PPDU Format is set to Non-HT: 
1 to (4095 – Diff) [octet(s)] 

 When System is set to 11n and PPDU Format is set to HT 
Mixed or HT Greenfield: 1 to (65535 – Diff) [octet(s)] 

 When System is set to 11ac: 1 to (65535 – Diff) [octet(s)] 
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[Remarks] Set the value using the numeric keypad. 
 Diff = Total Length (Mac Header + FCS) – (Sum of the 

MAC parameters set to Off in the Frame Format setting 
screen [octet(s)]) 

  Total Length=40 [octet(s)] 
 
MPDU Length 

[Function] Displays the MPDU length. 
[Default] The default for each system is as follows: 
 When System is set to 11a, 11g (with Frame Format set to 

DSSS-OFDM or ERP-OFDM), 11j, 11n or 11p: 1000 
[octet(s)]  

 When System is set to 11b or 11g (with Frame Format set 
to ERP-DSSS, ERP-PBCC or ERP-CCK): 1024 [octet(s)] 

 When System is set to 11n and Frame Format is set to 
Non-HT: 4095 [octet(s)] 

 When System is set to 11n and Frame Format is set to 
HT-Mixed or HT-Greenfield or when System is set to 11ac: 
4096 [octet(s)]  

[Display range] The display range for each system is as follows: 
 When System is set to 11a, 11b, 11g, 11j or 11p or when 

System is set to 11n and PPDU Format is set to Non-HT: 
(Diff+1) to 4095 [octet(s)]  
 When System is set to 11n and PPDU Format is set to HT 
Mixed or HT Greenfield: (Diff+1) to 65535 [octet(s)] 
When System is set to 11n and A-MPDU is set to ON: 
(Diff+1) to 4095 [octet(s)]  
When System is set to 11ac: (Diff+1) to 65535 [octet(s)] 
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MAC Data Type 
[Function]  Sets the type of data assigned to the MAC frame body. 
[Default] PN9fix 
[Setting range] PN9fix, PN15fix, 16bit repeat, User File 
[Remarks] Clicking Frame Body in the MAC Frame Format section 

displays the screen as shown below.  

 

Figure 4.2.11-3  MAC Data Type Setting Screen 

 

Frame Control 

[Function] Sets the frame control. 
[Default] 0x0800 
[Setting range] 0x0000 to 0xFFFF 
[Remarks] Set the value using the hexadecimal keypad.  

 

Duration/ID 

[Function] Sets the Duration/ID. 
[Default] 0x0000 
[Setting range] 0x0000 to 0xFFFF 
[Remarks] Set the value using the hexadecimal keypad.  
 
Address1 

[Function] Sets the MAC Address1. 
[Default] 0xFFFF FFFF FFFF 
[Setting range] 0x0000 0000 0000 to 0xFFFF FFFF FFFF 
[Remarks] Set the value using the hexadecimal keypad.  
 
Address2 

[Function] Sets the MAC Address2. 
[Default] 0x2022 2222 2202 
[Setting range] 0x0000 0000 0000 to 0xFFFF FFFF FFFF 
[Remarks] Set the value using the hexadecimal keypad.  
 This function is available in the following case:  

 Address2 SW=On.  
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Address2 SW 

[Function] Enables/disables the MAC Address2. 
[Default] On 
[Setting range] On, Off 
 

Address3 

[Function] Sets the MAC Address3. 
[Default] 0x5055 5555 5505 
[Setting range] 0x0000 0000 0000 to 0xFFFF FFFF FFFF 
[Remarks] Set the value using the hexadecimal keypad.  
 This function is available in the following case:  

 Address3 SW=On 
 
Address3 SW 

[Function] Enables/disables the MAC Address3. 
[Default] On 
[Setting range] On, Off 
 
Sequence Control 

[Function] Sets the Sequence Control. 
[Default] 0x0000 
[Setting range] 0x0000 to 0xFFFF 
[Remarks] Set the value using the hexadecimal keypad.  
 This function is available in the following case:  

 Sequence Control SW=On 
 

Sequence Control SW 

[Function] Enables/disables the Sequence Control. 
[Default] On 
[Setting range] On, Off 
 

Address4 

[Function] Sets the MAC Address4.  
[Default] 0x644D 2003 0000 
[Setting range] 0x0000 0000 0000 to 0xFFFF FFFF FFFF 
[Remarks] Set the value using the hexadecimal keypad.  
 This function is available in the following case:  

 Address4 SW=On 
 

Address4 SW 

[Function] Enables/disables the MAC Address4. 
[Default] On 
[Setting range] On, Off 
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QoS Control 

[Function] Sets the QoS control. 
[Default] 0x0000 
[Setting range] 0x0000 to 0xFFFF 
[Remarks] Set the value using the hexadecimal keypad.  
  This function is available in the following case:  

System=11n or, 
System=11ac and QoS Control SW=On.  

 
QoS Control SW 

[Function] Sets the QoS control.  
[Default] On 
[Setting range] On, Off 
[Remarks] This function is available in the following case:  

System=11n or System=11ac 
 

HT Control 

[Function] Sets the HT control.  
[Default] 0x0000 0000 
[Setting range] 0x0000 0000 to 0xFFFF FFFF 
[Remarks]  Set the value using the hexadecimal keypad.  
  This function is available in the following case:  

System=11n or,  
System=11ac and HT Control SW=On.  
 

HT Control SW 

[Function] Enables/disables the HT Control.  
[Default] On 
[Setting range] On, Off 
[Remarks] This function is available in the following case:  

System=11n or System=11ac 
 

Increment Sequence Number 

[Function] Sets whether to increment the sequence number. 
[Default] Off 
[Setting range] On, Off 
[Remarks] Set the value using the toggle button. 
 When Increment Sequence Number is set to On, the 

sequence number is incremented at the interval set by 
Sequence Number Increment Period, considering the 
high-order 12 bits of the Sequence Control as an initial 
value. 
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Sequence Number Increment Period 

[Function] Sets the interval to increment the sequence number. 
[Default] 1 
[Setting range] 1 to 15 
[Remarks] Set the value using the numeric keypad. 

 This can be set when Increment Sequence Number is set 
to On or when Increment Fragment Number is set to On. 

 

Increment Fragment Number 

[Function] Sets whether to increment the Fragment Number. 
[Default] Off 
[Setting range] On, Off 
[Remarks] Set the value using the toggle button.  

 When Increment Fragment Number is set to On, the 
frame number of each packet is incremented at the 
interval set by Sequence Number Increment Period, 
considering the low-order 4 bits of the Sequence Control 
as an initial value.  

 
FCS 

[Function] Sets whether to enable the MAC check sum function. 
[Default] On 
[Setting range] On, Off 
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4.3 Graph Display  
The generated waveform pattern can be displayed in a CCDF, FFT, and 
Time Domain graph by using this software.  

To display CCDF graph: 

(1) Generate a waveform pattern menu by executing “Calculation”. 

(2) Click  on the tool bar to display the CCDF graph screen and 
the generated waveform pattern trace.  

Displaying FFT graph 

(1) Generate a waveform pattern menu by executing “Calculation”.  

(2) Click  on the tool bar to display the FFT graph screen and 
the generated waveform pattern trace.  

Displaying the Time Domain graph 

(1) Generate a waveform pattern menu by executing “Calculation”.  

(2) Click  on the tool bar to display the Time Domain graph screen 
and the generated waveform pattern trace.  

 

For details of the graph screens, refer to sections 4.3 “CCDF Graph 
Display” , 4.4 “FFT Graph Display” and 4.13 “Time Domain Graph 
Display” in the MG3700A/MG3710A Vector Signal Generator MG3740A 
Analog Signal Generator Operation Manual (IQproducer™).  

. 
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4.4 Auxiliary Signal Output 
Select a waveform pattern generated by the WLAN IQproducer ™ on the 
mainframe to output the marker that is synchronized with the RF signal 
as an auxiliary signal from the AUX Input/Output on the rear panel of 
the mainframe. Markers described below are automatically set for the 
waveform patterns when they are generated. By using the Marker Edit 
function which is a peripheral function of the Time Domain graph, a 
waveform pattern can be generated with these markers edited. For 
Marker Edit function, refer to 4.13.12 “Marker edit function” in 
MG3700A/MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (IQproducer™).  
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The following operations are required to output a modulated signal from 
this equipment using the waveform pattern generated by this software: 

• Transferring waveform pattern to internal hard disk 
• Loading waveform patterns from the hard disk to the waveform 

memory 
• Selecting a waveform pattern to be output from this equipment 
 
This chapter explains the details of these operations. 
 

5.1 For MG3700A or MG3710A ....................................... 5-2 
5.1.1 Transferring waveform pattern to internal 

 hard disk ...................................................... 5-2 
5.1.2 Loading to Waveform Memory ...................... 5-4 
5.1.3 Selecting Waveform Pattern .......................... 5-5 

5.2 For MS2690A/MS2691A/MS2692A or MS2830A ...... 5-6 
5.2.1 Transferring waveform pattern to internal 

 hard disk ...................................................... 5-6 
5.2.2 Loading to Waveform Memory ...................... 5-6 
5.2.3 Selecting Waveform Pattern .......................... 5-7 
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5.1 For MG3700A or MG3710A 
This section describes how to download a waveform pattern created for 
the MG3700A/MG3710A to the hard disk of the MG3700A/MG3710A and 
output the pattern.  

5.1.1 Transferring waveform pattern to internal hard disk 
The waveform pattern created with this software can be transferred to 
the internal hard disk in the following ways:  

Note: 
This operation is not necessary if you are using MG3710A and 
have generated waveform patterns on MG3710A.  

For MG3700A 
• LAN 
• CompactFlash Card 
 
For MG3710A 
• LAN 
• External device such as USB Memory 
 
■Transferring from PC via LAN (MG3700A，MG3710A) 
Two IQproducer™ tools can be used to transfer a waveform pattern to 
the MG3700A/MG3710A via a LAN.  

• Transfer & Setting Wizard 
Start this wizard by clicking the Transfer & Setting Wizard button of 
this software or by selecting Simulation & Utility tab → Transfer & 
Setting Wizard from the IQproducer™ after creating a waveform 
pattern. For details, refer to Section 4.7 “File Transfer and Loading to 
Memory Using Transfer & Setting Wizard” in the 
MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™).  
Transferring a waveform pattern to the internal hard disk of the 
MG3700A/MG3710A, loading the waveform from the hard disk to the 
waveform memory, and then outputting the waveform pattern can be 
done using this wizard.  
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• Transfer & Setting Panel 
This function is loaded by selecting Transfer & Setting Panel in the 
Simulation & Utility tab of the IQproducer™. For details, refer to 
Section 5.2 “Transferring Waveform Pattern” in the 
MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™).  
Specify the folder that contains the waveform pattern to transfer to 
the MG3700A/MG3710A in the PC-side tree of Transfer & Setting 
Panel. 
 

■Transferring using a CF card (MG3700A) 
Copy the waveform pattern (***.wvi and ***.wvd files) to be downloaded 
to the MG3700A to the root directory of a CF card.  

Insert the CF card into the card slot on the front panel of the MG3700A, 
and then copy the file to the hard disk. For details about how to use a CF 
card to transfer a waveform pattern, refer to (1) “Loading waveform file 
in memory” in Section 3.5.2 of the MG3700A Vector Signal Generator 
Operation Manual (Mainframe). 

■Transferring via external device such as USB memory (MG3710A) 
For details about how to transfer a waveform pattern created using this 
software to the hard disk of the MG3710A, refer to Section 7.3.6 “Copying 
external waveform pattern: Copy” in the MG3710A Vector Signal 
Generator MG3740A Analog Signal Generator Operation Manual 
(Mainframe).  
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5.1.2 Loading to Waveform Memory 
To output a modulated signal using a waveform pattern, it is necessary to 
load the waveform pattern that was transferred to the internal hard disk 
of the MG3700A/MG3710A (described in Section 5.1.1 “Transferring 
waveform pattern to internal hard disk”) to the waveform memory. A 
waveform pattern can be loaded into the waveform memory in the 
following two ways.  

■Configuring using the mainframe  
A waveform pattern can be loaded into the waveform memory by using 
the instruction panel of the MG3700A/MG3710A or by using a remote 
command.  

For operation using the front panel, refer below: 

• Section 3.5.2 (1) “Loading waveform file in memory” in the MG3700A 
Vector Signal Generator Operation Manual (Mainframe) 

• Section 7.3.4 “Loading waveform pattern: Load” in the MG3710A 
Vector Signal Generator MG3740A Analog Signal Generator 
Operation Manual (Mainframe) 

 
For operation using remote commands, refer below: 

• Chapter 4 “Remote Control” in the MG3700A Vector Signal 
Generator Operation Manual (Mainframe) 

• Section 7.3.4 “Loading waveform pattern: Load” in the MG3710A 
Vector Signal Generator MG3740A Analog Signal Generator 
Operation Manual (Mainframe) 

 
■Using Transfer & Setting Panel of IQproducer™ 
A waveform pattern can be loaded from the LAN-connected PC to the 
memory by using Transfer & Setting Panel, which can be opened from 
the Simulation & Utility tab. For details, refer to Section 4.6 “File 
Transfer and Loading to Memory Using Transfer & Setting Panel” in the 
MG3700A/MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (IQproducer™). 
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5.1.3 Selecting Waveform Pattern 
Select a waveform pattern to use for modulation from the waveform 
patterns loaded into the waveform memory of the MG3700A/MG3710A 
according to Section 5.1.2 “Loading to Waveform Memory”. A waveform 
pattern can be selected in the following two ways. 

■Configuring using the MG3700A/MG3710A 
Waveform patterns to be used for modulation can be selected by 
operating the equipment panel or by using a remote command.  

For operation using the front panel, refer below:  

• Section 3.5.2 (4) “Outputting pattern loaded in Memory A for 
modulation in Edit mode” in the MG3700A Vector Signal Generator 
Operation Manual (Mainframe) 

• Section 7.3.5 “Selecting output waveform pattern: Select” in the 
MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (Mainframe) 

 
For operation using remote commands, refer below: 

• Chapter 4 “Remote Control” in the MG3700A Vector Signal Generator 
Operation Manual (Mainframe) 

• Section 7.3.5 “Selecting output waveform pattern: Select” in the 
MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (Mainframe) 

 

■Using Transfer & Setting Panel of IQproducer™ 
A waveform pattern can be loaded from the LAN-connected PC to the 
memory, and also selected for modulation. This is done by using Transfer 
& Setting Panel, which can be opened from the Simulation & Utility tab. 
For details, refer to Section 4.6 “File Transfer and Loading to Memory 
Using Transfer & Setting Panel” in the MG3700A/MG3710A Vector 
Signal Generator MG3740A Analog Signal Generator Operation Manual 
(IQproducer™). 

 



 

Chapter 5  How to Use Waveform Patterns 

5-6 

5.2 For MS2690A/MS2691A/MS2692A or MS2830A 
This section describes how to download a waveform pattern created for 
the MS2690A/MS2691A/MS2692A or MS2830A to the hard disk of the 
MS2690A/MS2691A/MS2692A or MS2830A and output the pattern.  

 

5.2.1 Transferring waveform pattern to internal hard disk 
For details about how to transfer a waveform pattern created using this 
software to the hard disk of the MS2690A/MS2691A/MS2692A or 
MS2830A, refer below: 

• Section 2.4.4 “Copying waveform file(s) to hard disk” in the 
MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Operation) 

• Section 2.4.4 “Copying waveform file(s) to hard disk” in the MS2830A 
Signal Analyzer Vector Signal Generator Operation Manual 
(Operation) 

 

Note:  
Transferring waveform patterns is not required if the patterns are 
created using this software. 

 

5.2.2 Loading to Waveform Memory 
In order to output a modulated signal using the waveform pattern, it is 
necessary to load the waveform patterns stored in the internal hard disk 
to the waveform memory.  

■Loading to Waveform Memory 
Waveform patterns can be loaded to waveform memories by operating the 
panel or by using a remote command.  

For operation using the front panel, refer below: 

• Section 2.4.1 “Loading waveform file in memory” in the 
MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Operation) 

• Section 2.4.1 “Loading waveform pattern(s) to memory” in the 
MS2830A Signal Analyzer Vector Signal Generator Operation 
Manual (Operation) 
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For operation using remote commands, refer below: 

• MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Remote Control) 

• MS2830A Signal Analyzer Vector Signal Generator Operation 
Manual (Remote Control) 
 

5.2.3 Selecting Waveform Pattern 
Select waveform patterns to be used for modulation from those loaded in 
the waveform memory as described in Section 5.2.1 “Transferring 
waveform pattern to internal hard disk” above. 

■Selecting waveform pattern 
Waveform patterns to be used for modulation can be selected by 
operating the equipment panel or by using a remote command.   

For operation using the front panel, refer below: 

• Section 2.4.2 “Loading waveform file in memory” in the 
MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Operation) 

• Section 2.4.2 “Loading waveform pattern(s) to memory” in the 
MS2830A Signal Analyzer Vector Signal Generator Operation 
Manual (Operation) 
 

For operation using remote commands, refer below: 

• MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Remote Control) 

• MS2830A Signal Analyzer Vector Signal Generator Operation 
Manual (Remote Control) 
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A list of error messages is shown below. In this list, x, n1, and n2 indicate 
a numeric value, and s indicates a character string. 

Table A-1  Error messages 

Error Message Description 
Calculation cannot start because of setting error. — 
Cannot open file — 
Cannot read file — 
Cannot read file(“s”) — 
Cannot write file — 
Cannot write file(“s”). — 
Burst On Length is too short. — 
Input Export File Name. — 
Input Package Name. — 

Invalid file format When loading complex data, this message is also 
displayed if binary data is loaded by mistake. 

Invalid value is set. — 

The Setting value is out of range.(“s = x(n1 – n2)”) The value of x set in parameter s is out of the 
setting range between n1 and n2. 

The sum of Data Length for each MPDU is out of 
range. (xxxxxx) 

For System=11n, the sum of Data Length exceeds 
65535 (maximum value). 
For System=11ac, Total A-MPDU Length exceeds 
65535 (maximum value). 
For System=11ac and when Oversampling 
Ratio=8, Bandwidth=20 MHz, MCS=0, Number of 
Spatial Streams=1, Total A-MPDU Length 
exceeds 42500 (maximum value). 

Memory option cannot be turned on in MS269x 
mode. 

— 

Operation disabled when 2nd SG (Opt-062, 064, 
066) not installed. 

—. 

Operation disabled when Bandwidth is 80+80 
MHz and Number of Antennas is not 1. 

— 

 
A list of warning message is shown below. 

Table A-2  Warning message 

Warning Message Description 
Clipping was done. — 
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This section shows examples of the two user file formats that can be used 
in this software. A user file must be a text file. It is not necessarily 
required to specify an extension to user files. Note that an error occurs if 
a user file that does not conform to the format is read.  

Be sure to write an unmodulated binary sequence into a user file. An 
error occurs if a user file that contains characters other than 0, 1, line 
feed, comma, period, and space is read. All line feeds, commas, periods, 
and spaces in a user file are ignored when the user file is read. 
A user file format example is shown below. 

User file format example   

0s and 1s in a user file are sequentially read from the leftmost of the first 
line. 

When the number of data to be processed is larger than that in the user 
file, the user file is read again from the top. If the user file contains more 
data than that to be processed, data reading terminates halfway. 
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